FINITE ELEMENT MODEL UPDATING FOR
ROTARY MACHINERY

A Thesis
presented to
the Faculty of California Polytechnic State University,
San Luis Obispo

In Partial Fulfillment
of the Requirements for the Degree
Master of Science in Mechanical Engineering

by
Nathalie Gotin
September 2012
COMMITTEE MEMBERSHIP

TITLE: Finite Element Updating for Rotary Machinery

AUTHOR: Nathalie Gotin

DATE SUBMITTED: September 2012

COMMITTEE CHAIR: James Meagher, Professor

COMMITTEE MEMBER: Hemanth Porumamilla, Assistant Professor

COMMITTEE MEMBER: Wolf-Immo Jutzler, Professor Dr.Ing.
Abstract

Finite Element Updating for Rotary Machinery

Nathalie Gotin

The main approach of this thesis was to develop a mathematical model that represents a rotary machine. Experimental data was used to define a finite element model (FEM). In order to obtain the experimental data, the rotary machine had to be balanced. An impact hammer test made it possible to obtain frequency response functions (FRF). The frequency response functions were curvefitted in order to obtain the mode shapes and natural frequencies.

Mathematical models have been created with ABAQUS and Matlab. For the Matlab Model the assumption has been made that the rotor machine consists of a specific number of beam elements. The FEM matrices have been reduced with the Guyan Reduction Method to coincide with the DOFs of the experiment. Applying the method of the least square to an Error Function made it possible to obtain new values for the stiffness and damping of the bearings ($\Delta k_1 = 1.0618 \times 10^{13}, \Delta k_2 = 3.0765 \times 10^{15}, \Delta c_1 = 3.2539 \times 10^5$ and $\Delta c_2 = 7.5465 \times 10^4$). This made it possible to update the mathematical model. By applying the Model Assumption Criterion the theoretical model and those detected from the experimental measurement could be validated. The correlation for Mode Shapes 1 could be improved from 0.6647 to 0.8186 and for Mode Shape 2 from 0.0209 to 0.4208. Therefore, the created method could be proven to work. Additionally the whole theory has been validated with a very simplified model.
# Contents

List of Tables .................................................................................................................. vii
List of Figures .................................................................................................................. viii
List of Abbreviations ....................................................................................................... x

Chapter 1: Problem Statement and General Terms and Definitions .................. 1

Problem Statement ....................................................................................................... 1
Finite-Element Modeling ................................................................................................. 2
Finite-Element Model Updating ..................................................................................... 3
Vibration Analysis ......................................................................................................... 4
  Frequency Response Function .................................................................................... 6
Impact Test .................................................................................................................... 12
  Curve fitting ................................................................................................................. 14
Data Plots .................................................................................................................... 14
Rotating machinery structures .................................................................................... 16
Dynamic Stiffness and Rotor Behaviour ................................................................... 22
  Dynamic stiffness ........................................................................................................ 23
  Synchronous Rotor Behavior ...................................................................................... 24

Chapter 2 – Experimental Measurements ................................................................. 25

Balancing ....................................................................................................................... 25
  Balancing with determining the Heavy Spot location .............................................. 26
  Multiplane Balancing With Influence Vectors ....................................................... 26
  Weight Splitting .......................................................................................................... 27
Experimental Setup Balancing Rotary Machine ....................................................... 28
  Obtaining Data .......................................................................................................... 31
  Test: Unbalance Setting ............................................................................................ 32
  Test: Obtaining Mode Shapes/ Natural Frequencies ............................................. 34
Mode Shapes ................................................................................................................ 35
Natural Frequencies .................................................................................................... 36
Experimental Setup Hammer Tip Testing ................................................................. 38
  Dactron Photon™ ...................................................................................................... 40
  FFT Windows ............................................................................................................. 42
  Obtaining Data .......................................................................................................... 44
Animation with MEScope ............................................................................................ 47
  Results ......................................................................................................................... 48
List of Tables

Table 1 Recommendations for different window types [4] .................................. - 42 -
Table 2 System of Units ......................................................................................... - 54 -
Table 3 Degree of Freedom/ Orientation ............................................................... - 58 -
Table 4 Comparison Natural Frequencies ............................................................. - 79 -
Table 5 Mass Normalized Shape Functions ......................................................... - 84 -
Table 6 MAC Mode Shape 1 before updating ...................................................... - 89 -
Table 7 MAC Mode Shape 2 before Updating ...................................................... - 90 -
Table 8 MAC Mode Shape 1 after Updating ....................................................... - 90 -
Table 9 MAC Mode Shape 2 after Updating ....................................................... - 91 -
List of Figures

Figure 1 Time Data .......................................................... - 6 -
Figure 2 Components of the Frequency Response Function .................. - 7 -
Figure 3 Anatomy of an FFT Analyzer .................................. - 8 -
Figure 4 Response of Simple Line ....................................... - 10 -
Figure 5 Mode 1 from fifth Row of a FRF Matrix ....................... - 11 -
Figure 6 Cascade ................................................................ - 11 -
Figure 7 Excitation and response location .................................. - 14 -
Figure 8 Modal Parameter Estimation ..................................... - 14 -
Figure 9 Different Measurement Techniques ............................. - 14 -
Figure 10 Bode Plot ......................................................... - 15 -
Figure 11 Free Body Diagram of a Rotor .................................. - 17 -
Figure 12 Rotor position vector ............................................. - 17 -
Figure 13 Vibration and Force response vectors ......................... - 22 -
Figure 14 Conversion of dynamic input forces to output vibration .... - 22 -
Figure 15 Weight Splitting .................................................. - 28 -
Figure 16 Rotor Kit Components .......................................... - 29 -
Figure 17 Rotor Kit Speed Controller .................................... - 30 -
Figure 18 Rotor Kit ........................................................... - 31 -
Figure 19 Partial view of ADRE for Windows ......................... - 32 -
Figure 20 Polar Plot .......................................................... - 33 -
Figure 21 RK 4 Rotor Kit Proximiter Assembly ....................... - 35 -
Figure 22 First Mode Shape ................................................. - 36 -
Figure 23 Second Mode Shape ............................................. - 36 -
Figure 24 Bode Plot .......................................................... - 37 -
Figure 25 Impact hammer instrument ..................................... - 38 -
Figure 26 Excitation and response location ............................. - 40 -
Figure 27 Dactron Focus II Real-Time Analyzer and Dactron Photon - 40 -
Figure 28 Input Dactron Signal Analyzer ............................... - 44 -
Figure 29 Exciting the rotary machine at location I and measuring at loc k .. - 45 -
Figure 30 Excitation at location 2 ......................................... - 46 -
Figure 31 Window MEScope .............................................. - 47 -
Figure 32 Simplified Model in Structur Window of MEScope ....... - 48 -
Figure 33 Curve Fitting ..................................................... - 49 -
Figure 34 Experimental Mode Shapes 1 and 2 ......................... - 50 -
Figure 35 Definition of Coordinate System ............................ - 52 -
Figure 36 Abaqus Creat Part and Edit Feature(right figure) ........ - 55 -
Figure 38 Sketcher of rotary machinery .................................. - 55 -
Figure 39 Edit Feature ....................................................... - 56 -
Figure 40 Create DATUM CSYS .......................................... - 56 -
Figure 41 Modeling Bearing and Coupling .............................. - 57 -
Figure 42 Create Partition ................................................... - 57 -
Figure 43 Partition Edge and Cell and Create Partition 2 (right figure) - 58 -
Figure 45 Edit Section ....................................................... - 60 -
Figure 46 Instance Part ...................................................... - 61 -
## List of Abbreviations

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADC</td>
<td>Analog to digital conversion</td>
</tr>
<tr>
<td>CAE</td>
<td>Computer Aided Engineering</td>
</tr>
<tr>
<td>DOF</td>
<td>Degree of Freedom</td>
</tr>
<tr>
<td>DSA</td>
<td>Dynamic Signal Acquisition</td>
</tr>
<tr>
<td>DAQ</td>
<td>Data Acquisition</td>
</tr>
<tr>
<td>DAIU</td>
<td>Data Acquisition Interface Unit</td>
</tr>
<tr>
<td>FRF</td>
<td>Frequency Response Function</td>
</tr>
<tr>
<td>FEM</td>
<td>Finite-Element Modeling</td>
</tr>
<tr>
<td>FFT</td>
<td>Fast Fourier Transformation</td>
</tr>
<tr>
<td>ODS</td>
<td>Operation Deflection Shape</td>
</tr>
</tbody>
</table>
Chapter 1: Problem Statement and General Terms and Definitions

Problem Statement
The primary approach of the work is to perform a finite-element modeling for a rotary machine.

To perform the finite-element modeling the physical structure of the actual rotary machine has to be translated into a mathematical model by means of a mathematical and numerical process. The mathematical model is used to estimate such dynamic characteristics as mode shapes and frequencies.

To better reflect the actual structure, the mathematical model is updated. Updating involved the process through which the mathematical model is tuned in a way to better reflect the actual structure. Therefore the assumption has to be made that the experimental data is correct and that the mathematical model is adapted.

The finite-element model matrices have to be equated to those of the measured modal data; therefore the physical structure has to be translated into a mathematical model with the Guyan Reduction Method.

Since the rotary machinery behavior is primary controlled by the dynamic stiffness, the unknown parameters for the stiffness and damping matrices have to be estimated. To estimate those an Error Function is applied to the data (involving theoretical and reference data) and solved by using method of the
least square. Finally the theoretical and reference data are compared using the Model Assurance Criterion. [1]

Finite-Element Modeling

Finite-Element Modeling is the mathematical and numerical process that translates a physical structure into a mathematical model. The dynamic characteristics can be estimated from this mathematical model. Those include the natural frequencies and mode shapes.

Originally FEM has been applied in complex elasticity and structural analysis tasks in the field of aerospace and civil engineering.

When developing a mathematical model discrepancies occur to the actual physical structure. This may be due to model structure errors and model parameter errors. Structure errors occur among others due to the difficulty to model damping and stiffness. Model parameter errors occur due to the complexity of identifying the correct material properties. In the scope of this work the assumption is made, that the measurements are correct, which excludes the reason of the discrepancy between the mathematical model and the actual physical structure due to measurement errors.

To model a structure, it is divided into a number of smaller bodies (finite elements). These finite elements are connected to each other at points (nodes). Therefore the whole structure can be analyzed without solving the problem for the entire body, but by formulating equations for every single finite element, which are then combined to receive the solution for the entire structure.
If the goal of developing a Finite-Element Model that represents the physical structure entirely is achieved, analysis can be done in order to improve the actual physical structure. [1] [10]

**Finite-Element Model Updating**
When performing an analysis of the mathematical obtained finite-element model it can be seen that the results do not necessarily coincide with the results obtained from the measured (reference) data.
There are two different methods to execute the updating of a mathematical model;

- the **direct method** and the
- **iterative method**.

The direct method reproduces the measured data precisely. It uses the modal properties.
The iterative method updates the finite-element model by changing its physical parameters. Reviewing previous research papers elucidates that just lately research has been done in the field of finite-element updating using an iterative procedure.
One way to apply the iterative method is to update the structural model matrices (e.g. the mass, stiffness and damping matrices). Thereby the distance between the analytical and the measured data is minimized.

\[
\{E\}_i = (-\omega_i^2 [M] + j \omega_i [C] + [K]) \cdot \{\phi\}_i \quad (1)
\]
Where $[M]$ is the mass matrix, $[C]$ the damping matrix, $[K]$ the stiffness matrix, $\{\phi_i\}$ the $i$th mode shape, $\omega_i$ is the $i$th natural frequency, $\{E\}_i$ the error vector (residual force) and $i = \sqrt{-1}$. The relevant parameters are changed until the error is minimized.

To be able to execute the Error Function the Degrees-of-Freedom of the Finite-Element Model and from the measurement have to be adapted. One way is to use the reduction and expansion method, with which the measured modal data and the Finite-Element System Matrices will be equated.

There are different reduction methods:

- static reduction (Guyan, 1965)
- dynamic reduction (Paz, 1984)
- improved reduced system (O'Callahan, 1989)
- system-equivalent-reduction process (O'Callahan et al., 1989)

To obtain the measured data, which will serve as the reference data for the mathematical model, a Vibration Analysis has to be executed. [1] [10]

**Vibration Analysis**

To execute the Vibration Analysis, the structure of the rotary machine has to be excited. Therefore a modal hammer is used to excite the structure. The raw data is then measured in the time domain and by applying the Fast-Fourier Transform the data is transformed into the frequency domain.

The modal properties are extracted from the Frequency Response Function using the procedure modal analysis. The Modal Properties are

- frequency,
• damping
• and the mode shapes.

It is important to identify where the frequencies occur and in which way they might affect the response of the present structure. Modal Analysis is used in all fields of mechanical engineering, including the automotive, airplane, computer and various other industries. By understanding where the frequencies and mode shapes occur makes it possible for the engineer to find the best solution in terms of noise and vibration applications.

The vibration deflection shape of a rotating structure is referred to as the mode shape. For every natural frequency occurring in a structure there is a characteristic deformation shape. It describes the axial distribution of the vibration amplitude and phase along the structure. They are defined by the material properties, mass, stiffness and damping.

Experimental modal parameters are obtained from measured Operating Deflection Shapes (ODS). Operating Deflection Shapes are the visualization of motion of two or more points on a structure. The motion at a point in a direction is called a Degree of Freedom (DOF). Since both, location and direction are correlated with motion it is a vector quantity.

In the experimental modal analysis the actual physical structure is excited and the motion of each chosen point (DOF) is measured.

At a resonance peak the Operation Deflection Shape is dominated by the natural frequency and therefore can be seen as a good approximation to the mode shape. [5] [20]
**Frequency Response Function**

To execute a modal analysis a structure is excited with a measurable force. By applying the Fast Fourier Transform to the time data, the **Frequency Response Functions (FRF)** can be obtained. Figure 1 shows the time data of the displacement at a sensor, while executing a hammer test.

![Figure 1 Time Data](image)

Therefore it can contain both, the real and imaginary parts and components. FRFs allow isolating the dynamic properties and modal parameters of a mechanical structure. A FRF is defined as a single input DOF (point and direction) and a single output DOF. The Frequency Response Function describes therefore how much displacement, velocity or acceleration has at an output DOF, per unit excitation force at an input DOF.
The peaks appear at the natural frequencies and can be seen in Figure 2. When overlaying time trace with the response trace it can be seen that the amplitude peaks occur at the same time. Therefore either the time trace can be used by determining the frequency at which the amplitude reaches its maximum or the response trace by determining where the resonant frequencies occur.

In the following Figure 3 the basic steps to obtain the FRF from the measured data is explained. First the analog signals have to be filtered to prevent aliasing. Then the analog signal is converted by the analog to digital converter (ADC) into a digital representation of the actual signal. To prevent leakage weighting functions (windows) are used. As the data is sampled the Fast Fourier Transformation can be computed and forms linear spectra from the input excitation and the output response. These are averaged and used to obtain the Frequency Response Function and the Coherence. Coherence is a function that represents how much the output signal is related to the input signal. FRF
contains information about the damping, the system frequency and important information considering the mode shapes at the measured location.

Figure 3 Anatomy of an FFT Analyzer

If a structure is equipped with a certain amount of measurement locations, there are the same numbers of possible places where the forces can be applied. To assign the input and the output location of the FRF, subscripts are used: \( h_{\text{out,in}} \) (matrix notation: \( h_{\text{row, column}} \)).

FRF contains information about the damping, the system frequency and important information considering the mode shapes at the measured location. It is the ratio of the output response (which can be measured as the displacement, the velocity or the acceleration) as a result of the applied force. This means it describes how a structure affected by a certain force causes it to respond.
The linear model for a vibratory structure can be written as

$$\{X(\omega)\} = [H(\omega)][F(\omega)]$$  \hspace{1cm} (2)

$\{X(\omega)\}$ is the $n$-vector of Fourier transformed displacement response, $[H(\omega)]$ is the $(n \times n)$ matrix of FRFs and $\{F(\omega)\}$ is the $n$-vector of Fourier transformed inputs.

In the $[H(\omega)]$, which is the $(n \times n)$ matrix of FRFs the row corresponds to the response points and the columns correspond to excitation points. Any particular row or column contains sufficient information to compute the complete set of frequencies, damping and mode shapes.

$$\begin{bmatrix}
H_{11} & H_{12} & H_{13} & \cdots & H_{1N} \\
H_{21} & \ddots & \ddots & \ddots & \ddots \\
H_{31} & & \ddots & \ddots & \ddots \\
\vdots & & \ddots & \ddots & \ddots \\
H_{N1} & & & \ddots & H_{NN}
\end{bmatrix}$$

The FRF matrix can be also expressed in terms of modal parameters:

$$[H(\omega)] = \sum_{k=1}^{\text{modes}} \frac{[R_k]}{2j(\omega - \sigma_k)} - \frac{[R_k^*]}{2j(\omega - \sigma_k^*)}$$  \hspace{1cm} (3)

$[R_k]$ is the $(n \times n)$ matrix of residues for mode $(k)$, $p_k = \sigma_k + j\omega_k$ is the complex pole location for mode $(k)$ and $\omega_k$ is the frequency for mode $(k)$. * stands for the complex conjugate.

From the matrix of residues for modes the mode shapes can be obtained. They are related by $[R_k] = A_k [u_k] [u_k]^T$, where $u_k$ is the mode shape of the corresponding mode $k$ and $A_k$ is the scaling vector for mode $k$.

Therefore the transfer function along the $j\omega$-axis in the S-plane is the Frequency Response Function. The transfer function is of complex value, since the Laplace variable is complex valued. [5] [11]
**Mode Shapes**

Depending on the frequency with which the structure is excited, the deformation has different deformation patterns. At each one of the natural (resonant) frequencies a specific deformation pattern in the structure is excited. As can be seen in the Figure 4 below the deformation pattern at the first natural frequency is bending, the second natural frequency has a twisting deformation pattern.

![Mode 1 and Mode 2](image1.png)

**Figure 4 Response of Simple Line**

Deformation patterns are referred to as mode shapes of a structure. The weight and stiffness of a structure disposes where the natural frequencies and the mode shapes will exist.

To extract the mode shapes from measured data the peak amplitude of the imaginary part of the FRF has to be regarded. Here (Figure 5) all the imaginary parts of the single FRFs for the the 5th row are shown. This means that the structure was excited at every point and it was measured at one reference location. The peak amplitude of the imaginary part ($j\omega$) at the same frequency in every FRF is joint to show the shape of the first mode. Therefore it can be seen,
that just the measurement of a row can be used to describe the mode shape of
the system.

Figure 5 Mode 1 from fifth Row of a FRF Matrix

It is important to consider that the reference point cannot be at the node of a
mode. If this is the case the mode is not visual in the frequency response
function and therefore the mode cannot be obtained. To visualize the mode
shapes even better, it is convenient to show all frequency response functions in a
waterfall or Cascade style plot (Figure 6). [11]

Figure 6 Cascade

A drive point is where the structure is measured and excited at the same point.
In the experiment six measurement points are used. If the structure is excited
with the impact load at point 1 and the measurement is done at the same
location, the measurement is referred to as $h_{1,1}$. Typical of a drive point measurement is that the resonance frequencies are all separated by anti-resonances. Furthermore the phase loses $180^\circ$ when the resonance is passed and gains $180^\circ$ when the anti-resonance is passed. Additionally all peaks of the imaginary part point in the same direction.

Usually in frequency response functions reciprocity is found. This means that the frequency response function is symmetric ($h_{ij}=h_{ji}$). Therefore not all terms of the frequency response function have to be measured. Since in this thesis the rotary machinery is considered, the circumstances are different. [5]

**Impact Test**

Principally there are two different test cases to obtain vibration data, the shake test and the impact test. In the scope of this work, the impact test will be executed.

Usually when performing an impact test, accelerometers are mounted on the structure. Accelerometers can affect the results, because their weights are considerable in comparison to the effective weight of the structure. Especially for light-weight structures this can be a concern and has to be considered. One way is to mount all accelerometers on the structure even if just a few are used, another possibility could be to add dummy weights to the structure, which will eliminate the roving mass effect. In this thesis non-contacting distance sensors are used which will not influence the rotary machinery.

The selection of the hammer tip is essential for the experimental measurement. The harder the tip, the wider the frequency ranges. The hammer tip has to be
selected carefully to ensure that all modes of interest are excited. If a too soft hammer tip is selected the modes are not excited sufficiently and the result of the measurement will not be good enough. This means the input power spectrum does not excite all the modes since there is a roll-off. A roll-off describes the steepness of a transmission function over the frequency. The coherence function is as well evidence for that since it is seen to deteriorate. The frequency response function has the same behavior over the second half of the frequency range. [12]

By executing the impact test on the rotary machinery, the Column Row Method can be applied.

The response behavior of the rotor can be characterized by the complex frequency response function, when the rotor is excited at a specific position \( l \) through by means of a harmonic force function \( \tilde{f}_l \) (with exciter frequency \( \Omega \)) and the displacement \( \tilde{q}_k \) measured at point \( k \). \( \epsilon_{kl} \) is the phase between two signals.

\[
H_{kl}(\Omega) = \frac{q_k e^{i(\Omega t - \epsilon_{kl})}}{f_l e^{i\Omega t}} = \frac{q_k}{f_l} e^{-i\epsilon_{kl}} \quad (4)
\]

R. Nordmann showed in his paper "Modal Parameter Identification and Sensitivity analysis in Rotating machinery" that the complex frequency response function also can be written with respect to the eigenvalues \( \lambda_j \) and the corresponding eigenvectors \( \varphi_j, \psi_j \). [6]

\[
H_{kl}(\Omega) = \frac{\tilde{q}_k}{f_l} = \frac{q_k}{f_l} e^{-i\epsilon_{kl}} = \sum_{j=1}^{2N} \frac{\varphi_{kj}^* \psi_{lj}}{i\Omega - \lambda_j} \quad (5)
\]
**Curve fitting**

After the frequency response measurements have been made parameter estimation techniques (curve fittings) are applied to determine the modal parameters.

**Figure 8 Modal Parameter Estimation**

Frequency Response Functions can be measured with Single-Point Excitation and Multiple-Points Excitation. The following is a short overview of the different measurement techniques.

**Figure 9 Different Measurement Techniques**

**Data Plots**

The most common data plot is the time-based plot. The instantaneous value of one parameter (usually displacement, velocity or acceleration) from a single
transducer on a short scale is usually displayed. Filtered or unfiltered vibration data is shown. They Keyphasor event is indicated by a blank or dot sequence.

The data for an **Orbit Plot** comes from a XY transducer (have to be perpendicular to each other). The transducer observes the rotation of a rotor and can be displaced in two independent timebased plots. When those two plots are combined an orbit plot is produced. The notch is detected by a Keyphasor transducer.

The **Bode Plot** seen in Figure 10 presents the data from a startup or shutdown of a machine and shows the frequency response in dependency of amplitude and phase respectively. [5]
Rotating machinery structures

A rotating machine can be regarded as a structure, which consists of rotating and non-rotating components such as a motor, turbine or pump. The dynamic behavior is identified by the properties of the component parts and especially the bearings since most machines operate below any bending modes.

Rotor Systems are subjected to static (constant in direction and time) and dynamic forces (change in magnitude or direction through time). Static forces produce a static deflection, whereas dynamic forces produce vibration, which can be torsional, radial and axial. Radial is the most common vibration problem, whereas axial is less frequent. Usually torsional vibration is neglected since it is difficult to measure. Through cross-coupling mechanisms torsional and axial vibration can produce radial vibration.

Rotor systems can usually be modeled with a small number of modes. With an increasing machine speed, the number of significant modes increase. Each mode can be modeled like a single degree of freedom if modal mass and modal stiffness are used.

\[ \omega_n = \frac{\sqrt{K}}{M} \]  

(6)

The natural frequency is also named mode, or natural mode. "Each natural frequency is associated with a particular vibration pattern, called a mode shape, and each mode shape is independent of all the other mode shapes of the system."

Modes can be distinguished between in-phase and out-of-phase modes. In-phase means that the masses move in the same direction, whereas out-of-phase
means that the masses move in opposite directions. The values of the mass and stiffness elements of the system decide on the frequencies of the modes and the relative amplitudes of vibration.

**Free Body Diagram of a rotor machine**

For a better comprehension of the forces on a rotor, consider the free body diagram shown below in Figure 11:

\[
\begin{align*}
F_D &= \text{damping force} \\
F_P &= \text{unbalance force} \\
F_S &= \text{radial restoring force from bearing and shaft} \\
F_T &= \text{tangential fluid force from fluid}
\end{align*}
\]

\[
\begin{align*}
F_D &= -D\dot{r} \\
F_P &= mr_0\omega^2 r(\omega t + \delta) \\
F_S &= -Kr \\
F_T &= jD\lambda\Omega r
\end{align*}
\]

*Figure 11 Free Body Diagram of a Rotor*

All forces are assumed to act through the rotor mass center. The position of the center of the rotor relative to the equilibrium position is described through the rotor position vector \( r \), which is defined as a complex rectangular plane.

**Rotor position Vector**

*Figure 12 Rotor position vector*
The vibration vector is described by the amplitude and the absolute phase of the transducer (filtered) signal. The length of the vector demonstrates the amplitude, whereas the angular position shows the absolute phase of the signal. The plot in Figure 12 shows the X and Y axes, which represent the real and imaginary axes of the complex plane. The equilibrium position of the rotor is the origin of the coordinate system. They will coincide if no external forces act on the rotor. The position of the center of the rotor relative to its equilibrium position is described with the vibration vector \( r \).

The vibration vectors are noted in polar representation as

\[
  r = A \angle \Phi \quad (7)
\]

where \( r \) is the displacement vibration vector, \( A \) is the vibration amplitude and \( \Phi \) is the phase angle.

The position of the center of the rotor in \( X \) direction is represented by \( x \) and in \( Y \) direction by \( y \). It is defined in polar representation as

\[
  r = x + jy \quad \text{with} \quad j = \sqrt{-1}.
\]

It follows that the magnitude of the rotor position vector is \( A = |r| = \sqrt{x^2 + y^2} \).

The position vector in exponential notation is

\[
  r = x + jy = Ae^{j\theta} \quad (8)
\]

which was shown by Leonard Euler (1707-1783) and with \( e = 2.71828 \ldots \) (base of the natural logarithms). \( \theta \) becomes a function of time \( \theta = \omega t + \alpha \), where \( \alpha \) is the absolute phase angle (at \( t=0 \)), when the Keyphasor event occurs.

This leads to a general expression for \( r \):
Due to differentiation the velocity and acceleration are obtained:

\[ \dot{v} = \frac{dr}{dt} = \dot{r} = j\omega Ae^{j(\omega t + \alpha)} \quad (10) \]

\[ \dot{a} = \frac{d\dot{r}}{dt} = \ddot{r} = -\omega^2 Ae^{j(\omega t + \alpha)} \quad (11) \]

Forces and Stiffnesses

\( F_S \) is the spring stiffness. \( K \) combines all spring stiffness of the rotor system and is obtained from the series/parallel combination of namely the shaft, the bearing, bearing support stiffness and the foundation stiffness. The term contains a minus sign because the bearing spring force points in the opposite direction to the rotor position vector.

\( F_P \) is the rotating perturbation force, which describes the disturbance of a system. An example therefore can be an unbalance. The rotating perturbation force has the magnitude \( mr_u \omega^2 \), where \( m \) is the unbalance mass (the heavy spot), \( r_u \) the distance from the center of the journal to the rotor center and \( \omega \) is the perturbation frequency.

\( F_D \) is the damping force and acts in the opposite direction to the instantaneous velocity vector. It is proportional to the viscous damping constant, \( D \) and the magnitude of the instantaneous velocity vector.

The tangential stiffness force \( F_T \) is expressed by the term \( jD\lambda\Omega r \) (tangential stiffness). \( \Omega \) is the angular velocity of the rotor, \( D \) is the damping constant of the bearings and \( \lambda \) is the Fluid Circumferential Average Velocity Ratio, which is defined as \( \lambda = \frac{\overline{v_{avg}}}{\overline{\Omega}} \) where \( \overline{v_{avg}} \) is the fluid average angular velocity.
Keyphasor Event

When working with rotor machinery, unbalances are very common. Therefore it is necessary to have a fixed, timing reference signal in order to make phase measurements. A once-per-turn reference signal has to be obtained. In the experiment an eddy current displacement transducer is facing a keyway, but other shaft configurations are also realizable. When the keyway is passing the transducer, the distance will increase and as a result the signal voltage will suddenly become less. After passing the keyway the voltage will get back to the level it had before. The abrupt change in voltage is called keyphasor event. This event is used to determine the lapsed time between the keyphasor event and the event of another signal. The keyphasor is an important tool when determining the characteristics of the dynamic response of the rotor and the rotor speed. [5]

Equation of Motion

By applying Newton’s Second law, the equation of motion is obtained. For completeness also the tangential stiffness term is included.

\[ F_s + F_T + F_D + F_P = M \ddot{r} \quad (12) \]

The expressions for the forces are substituted in the equation of motion:

\[ -Kr + jD\lambda \Omega r - D \dot{r} + m r_u \omega^2 e^{i(\omega t + \delta)} = M \ddot{r} \quad (13) \]

By reorganizing the standard form of a differential equation is obtained:

\[ M \dddot{r} + D \ddot{r} + (K - jD\lambda \Omega)r = m r_u \omega^2 e^{i(\omega t + \delta)} \quad (14) \]

With no fluid circulation \( \lambda \) is equal to zero and the equation reduces to:

\[ M \dddot{r} + D \ddot{r} + Kr = m r_u \omega^2 e^{i(\omega t + \delta)} \quad (15) \]
The term on the right-hand side is equal to zero if a free (unforced) behavior of the system is described. [5]

Solution of equation of motion

To solve the equation of motion, the general expression for $r$ is assumed to be harmonic. Due to differentiation the velocity $\dot{r}$ and acceleration $\ddot{r}$ are obtained and by substitution and elimination of the time terms the following expression is obtained:

$$ A e^{j\alpha} = \frac{m r_0 \omega^2 e^{j\delta}}{[K - M \omega^2 + j D (\omega - \lambda \Omega)]} \quad (16) $$

This equation describes for the moment that the Keyphasor event occurs the amplitudes and absolute phases. Simplified the equation states following:

$$ Vibration = \frac{\text{Force}}{\text{Dynamic Stiffness}} \quad (17) $$

Therefore can a change in vibration be caused either by a change in force, the dynamic stiffness or both.

In the following Figure 13 the force and vibration response vectors are shown at the moment the Keyphasor moment occurs. The two vectors (rotating with the angular velocity $\omega$) are here shown in a way, that the response vector lags the force vector, but also the opposite can be true. $\delta$ is the phase of the perturbation force and $\alpha$ is the phase of the response vector when the Keyphasor event occurs at $t=0$. [5]
Dynamic Stiffness and Rotor Behaviour

When examining rotor machines it is beneficial to regard it as a system that takes dynamic force as an input and produces vibration as an output.

The force is acting through the dynamic stiffness of the rotor system and therefore is the reason for the vibrations. Vibration is therefore a ratio of the applied dynamic force to the dynamic stiffness of the rotor stiffness. Therefore a change in the vibration is either through a change in the applied force or the dynamic stiffness.

Theoretically an infinite number of resonances are possible. Rotatory machines exhibit numerous resonances during their startup and shutdown, but when examining a machine, usually just the lower few resonances are important. [5]
**Dynamic stiffness**

Describing dynamic stiffness physically; it is a combination of static effects of the springs and tangential stiffness accompanying the dynamic effects of mass and damping.

The Nonsynchronous Dynamic Stiffness (if $\omega \neq \Omega$) controls the rotor response due to an applied dynamic force at any frequency and is expressed as

$$K_N = K - M\omega^2 + jD(\omega - \lambda\Omega) \quad (18)$$

With $K_D = K - M\omega^2$ is the nonsynchronous Direct Dynamic Stiffness and $K_Q = jD(\omega - \lambda\Omega)$ is the Quadrature Dynamic Stiffness.

When writing the equation of the nonsynchronous stiffness in the following way, the internal and external rotor system forces can be explained easier.

$$K_N = K - M\omega^2 + jD\omega - jD\lambda\Omega \quad (19)$$

$K$ is the spring stiffness of the rotor system (which is a combination of the fluid-film bearing stiffness, the bearing support stiffness, the foundation stiffness and the shaft stiffness) and will oppose the applied force. The second term $-M\omega^2$ is the mass stiffness. It appears as a dynamic term because of the inertia of the rotor. The term is negative because it will create a force that will be opposite the spring stiffness. The third term $jD\omega$ is called the damping stiffness. It acts $90^\circ$ to the direction of the applied force and stabilizes the rotor. The fourth term $-jD\lambda\Omega$ is a function of the fluid circumferential average angular velocity.

Synchronous stiffness (if $\omega = \Omega$)

$$K_S = K - M\Omega^2 + jD(1 - \lambda)\Omega \quad (20)$$
When applying a static load, the perturbation frequency $\omega$ is zero and just the first and fourth term is remained.

For both, the synchronous and the nonsynchronous Direct Stiffness, the Direct Dynamic Stiffness is the same. The Quadrature Dynamic Stiffness plots have in both cases a straight line, but with different slopes. [5] [13]

**Synchronous Rotor Behavior**

If the rotor response is controlled by a synchronous (1X) force (e.g. unbalance) it is called Synchronous Dynamic Stiffness. The terms in the Synchronous Dynamic Stiffness equation are associated with the rotor response in three speed ranges. These are at, below, and above the balance resonance.

At speeds well below a resonance the rotor high spot is in phase with the heavy spot. The spring stiffness dominates. At resonance speed, just the Quadrature Dynamic Stiffness is remained. The rotor amplitude is at its peak and the heavy spot is lagged by the high spot by $90^\circ$. Above the resonance speed the mass stiffness controls the response. The high spot lags now $180^\circ$ and the vibration amplitude approaches a constant level. [5] [13]
Chapter 2 – Experimental Measurements

Chapter 2 describes the experimental measurements that have been performed to obtain the reference data. This will include the setup, the balancing of the machine, the use of MEScope, and execution of the hammer test. Data obtained will make it possible to update the mathematical models. [17] [19]

Balancing

Before the experimental testing can be done, the rotatory machine has to be balanced. Ideally the geometric center is located at the center of all masses, but in reality that is not necessarily the case, due to non-uniform radial mass distribution. This may be due to holes in the casting, manufacturing tolerance, (also containing machining and stacking errors), and nonsymmetric construction (due to keys or pins).

The mass center of the rotor system is therefore some radial distance and a specific direction away from the geometric center. The unbalance of the rotor is the product of the rotor mass $M$ and the radial distance $r_e$. The formula below shows that the magnitude of the unbalance can also be calculated over the unbalance mass $m$ (the heavy spot) and a larger distance $r_u$. The larger distance $r_u$ is usually the radius of the balance circle.

$$M \cdot r_e = U = m \cdot r_u \quad (21)$$

The unbalance produces a force which is proportional to its mass, its radius, and the square of the rotor speed $\Omega$. The following force shows that the force is generated due to the centripetal acceleration of the unbalanced mass.

$$F = U \cdot \Omega^2 \quad (22)$$
To balance the rotatory machinery, two different techniques were used. First the machine was balanced with determining the Heavy Spot location and attaching the suitable calculated weight (for a suitable start of balancing the machine the state rule was used), and then the machine was balanced with the help of influence vectors. Note that the presented techniques are the most suitable for multiplane balancing and multiple modes. In the case of singleplane balancing, different techniques would be more appropriate. [13]

**Balancing with determining the Heavy Spot location**

The characteristic with multiplane balancing is that two or more planes have to be balanced simultaneously. In the present case, of two disks with balance holes on a shaft are used.

To determine the weight and angular position of an additional mass for the two-plane balancing, the vibrations of two-rotor system have to be examined. This analysis leads to the determination of the heavy spot. The angular position and the magnitude of the influence vector are used to find the position for the calibration weights. This calibration weight reduces, in theory, the amplitude of the vibrations in the system.

**Multiplane Balancing With Influence Vectors**

When balancing with influence vectors, the rotatory machine has to be run at a single operating speed.

The magnitude and the phase of the vibration response vector for plane 1 and plane 2 have to be examined. It has to be considered that an added weight in one plane (either plane 1 or plane 2) is influencing both, the response in plane 1,
as well as the response in plane 2. This means that two experiments have to be run to collect all the data that is needed to finally balance the rotatory machine sufficiently.

Weight has to be added in one plane, and after determining the influence vectors it has to be removed. The same weight will be added to the other (second plane) and the same procedure has to be realized. [13]

Weight Splitting
Often the exact angular position of the weight that has to be added is not available, it is between two holes or the weight itself is too heavy. In these cases the process of weight splitting is applied.

This means that if a specific weight $m$ is need at the angular position $\theta$, the weight has to be divided into $m_1$ at angular position $\theta_1$ and $m_2$ at angular position $\theta_2$.

The force produced by the weight is dependent on the mounting radii. In the present case all holes are at the same radius, so the following derivations are based on this circumstance.

When treating the masses and angles as vectors, the requirement becomes

$$m_1 + m_2 = m$$  \hspace{1cm} (23)

and in complex numbers becomes

$$m_1 e^{i\theta_1} + m_2 e^{i\theta_2} = m e^{i\theta}$$

When equating real and imaginary parts, the following system of equations is obtained

$$\begin{bmatrix} \cos \theta_1 & \cos \theta_2 \\ \sin \theta_1 & \sin \theta_2 \end{bmatrix} \cdot \begin{bmatrix} m_1 \\ m_2 \end{bmatrix} = \begin{bmatrix} m \cos \theta \\ m \sin \theta \end{bmatrix}$$
Solving this system of equations numerically leads to the solution for the weight needed. [5]

\[ m_1 = m \left( \frac{\sin(\theta_2 - \theta)}{\sin(\theta_2 - \theta_1)} \right) \]

\[ m_2 = m \left( \frac{\sin(\theta - \theta_1)}{\sin(\theta_2 - \theta_1)} \right) \]

Figure 15 Weight Splitting

**Experimental Setup Balancing Rotary Machine**

To simulate the actual rotating machine behavior, the **RK4 Rotor Kit from Bently Nevada** is used. It has a unique geometry and enables the user to isolate and control individual machine characteristics.

To capture the specific machinery data, **ADRE for Windows**, a multi-channel machinery data acquisition system is used. It combines the features and the performing abilities of the oscilloscopes, the spectrum analyzers, filters and recording instruments. Therefore additional equipment is seldom needed. The system can be used with its real-time display capability, which demonstrates the
captured data on the screen as it is recorded. The system consists of the Data Acquisition Interface Unit, the ADRE for Windows software and a computer system which is capable of running the software. The system needs either an AC or battery power to run. Since it is completely portable it allows operation in almost every environment. It provides support for all standard and non-standard input types. These are amongst others the dynamic transducer signals, the static signals and the speed input signals.

The following Figure 16 demonstrates the **RK4 Rotor Kit from Bently Nevada** consists of a Rotor Kit, the Motor Speed Controller, the TK 21 Keyphasor Signal Conditioner, the Oscilloscopes and the 208 DAIU.

![Figure 16 Rotor Kit Components](image)

The V-frame design of the Rotor Kit provides an advanced control of the housing dynamic stiffness properties. The electric motor can closely hold the desired speed with changes in loading conditions, since a direct current motor and control circuitry are combined. The motor can either run clockwise, or counter-clockwise and it also has a slow roll speed capability.
The Figure 17 above displays the following items: The Rotor Kit Speed Controller provides power for the rotor kit and the remaining devices. Ramp Rate allows the user to regulate how many rpm/min the radial velocity of the rotor machine increases until it reaches the maximal radial velocity, which is inserted over Max Speed Setpoint. Whether the radial velocity increases or decreases can be set over Ramp (Up/ down).

The function of the TK21 Keyphasor Signal conditioner is to manipulate the analog signal, thus it coincides with the requirements for further processing.

The 208 DAIU (Data Acquisition Interface Unit) is a portable system for multi-channel machinery data acquisition, that works together with the ADRE for Windows® Software (Automated Diagnostics for Rotating Equipment). For consistency with the Chapter 4, “Matlab Finite Element Model Creation”, the measurement points are numbered as 2, 4, 5 and 7.
Obtaining Data

1. After everything has been prepared to collect data in ADRE for Windows (see Appendix A) the measurement can be started.

2. At the Rotor Kit Motor Speed Controller the right lower was shifted to **SLOW ROLL**

3. **Store Enable** was clicked in the main menu and the real time values, as well as the chosen plots are displayed

4. At the Rotor Kit Motor Speed Controller left lower switch was toggled to **RAMP UP**. The rotor kit increased its radial velocity until it reached the maximal radial velocity (8000 rpm)

5. In the 208 DAIU control menu, to finish collecting data **Stop Sample** was toggled and then **Close** was clicked. At the Rotor Kit Motor Speed Controller the left lower switch was toggled to **RAMP DOWN**. When it
reached a radial velocity smaller than 300 rpm, the right lower switch was toggled to **STOPPED**.

6. In the menu bar different buttons appeared:

![Figure 19 Partial view of ADRE for Windows](image)

Namely from left to right: Orbit, OTB, Timebase, Trend, XY Graph, Vector Tabular, Polar, Bode, ShaftCL, HalfSpectrum Cascade, HalfSpectrum Waterfall, HalfSpectrum and Orbit. By clicking the icons the different plots were displayed.

**Test: Unbalance Setting**

To test the unbalance setting, the radial velocity of the machine was increased using a rotor speed controller to 8000rpm. Data is collected with the measurement probes 2 and 7 (see Figure 18). The collected data is used to determine the magnitude and phase of the vibration response in plane 1 and 2. When first running the experiment, the collected data shows clearly that the rotor machinery is very unbalanced. For the speed range close to the first natural frequency, no value is displayed, because the amplitude of the natural frequency is too high. While running the test, the whole rotor machine was making loud noises and the displacement of the rotor is visually apparent without looking on the plots.
As seen in Figure 20, the experiment had to be shut down after 3000 rpm because the amplitude of the vibration was already too high for the first mode, and it is sufficient to determine the heavy spot and adjust the calibration weight at the appropriate position. The experiment was repeated several times and with an Excel Sheet provided by Professor Dr. Meagher (which contains the theory described in the Chapter “Weight Splitting”) the appropriate weight for each position could be found. The Excel Sheet is attached in Appendix B. The rotor machine could be balanced to the point where none of the amplitudes at the natural frequency would be higher than 10 mill pp.
Test: Obtaining Mode Shapes/ Natural Frequencies

At this point two additional measurement points were attached, namely measurement point 4 and 5. The experiment was measured with two Bently Nevada measurement kits simultaneously. The experiments were displayed with ADRE® for Windows® / DAIU (see Figure 18).

The additional measurement points 4 and 5 were realized by using parts of an additional RK4 Rotor Kit from Bently Nevada.

Setup for additional probes 4 and 5:

To measure the shaft rotative speed and have a reference for measuring the vibration phase lag angle, the Keyphasor signal is used. Therefore the same Keyphasor signal is used on both RK 4 Rotor KIT Proximior Assemblies.

The input from the Keyphasor Probe goes into the RK 4 Rotor KIT Proximior Assembly. The output is then lead to the TK 21 oscilloscope and then to the 208 DAIU. To use the same Keyphasor signal a splitter is used. The Keyphasor output signal is split and lead to the 208 DAIU of the second RK 4 Rotor Kit.
Proximior Assembly. In this way the experiment can be run on both 208 DAUI workstations simultaneously. The collected data is compiled after finishing the experiment.

The experiment is conducted as described in the Chapter **Obtaining Data**.

**Mode Shapes**

From the obtained data the dynamic rotor behavior can be defined. To estimate the mode shapes, there are two ways to obtain them, either with the 1X polar plots or more precisely with the 1X orbit plots.

Polar Plots: This technique is using a single transducer per measurement plane. The startup (usually) or shutdown data is displayed at points along the length of the rotor. The plots are positioned in a way which represents the axial location on the machine. Additionally, all plots have the same full scale range.

The rotor mode shape can more accurately be estimated using 1X orbits. This requires two transducers. The orbits are plotted at the same scale and the Keyphasor dots are connected.
Natural Frequencies

From the Bode Plot the natural frequencies of the system can be determined.
Figure 24 Bode Plot

The natural frequency for mode 1 is at 1820 rpm, the natural frequency for mode 2 is at 5400 rpm.
Experimental Setup Hammer Tip Testing

For the hammer tip test the Dactron Focus II Real-time Signal Analyzer is used. The structure is excited with a specialized measurement tool, here an impact hammer, which produces short duration vibration level.

![Impact hammer instrument](image)

The impact hammer has a load cell (sensor which produces a signal proportional to the force of impact) to measure the excitation force and different hardness tips. The different hardness tips allow the adjustment of the frequency content of the impact force. The hammer tip has to be selected carefully to ensure that all modes of interest are excited. If a too soft hammer tip is selected, the modes are not excited sufficiently and the result of the measurement will not be accurate enough. Therefore selecting a hard hammer tip leads to an excitation that will have higher frequency content and is impacted for a shorter time.

The response behavior of the rotor can be characterized by the complex frequency response function, when the rotor is excited at a specific position \( l \).
through by means of a harmonic force function \( \tilde{f}_l \) (with exciter frequency \( \Omega \)) and the displacement \( \tilde{q}_k \) measured at point \( k \). \( \varepsilon_{kl} \) is the phase between two signals.

\[
H_{kl}(\Omega) = \frac{q_k e^{i(\Omega t - \varepsilon_{kl})}}{f_l e^{i\Omega t}} = \frac{q_k}{f_l} e^{-i\varepsilon_{kl}} \quad (4)
\]

R. Nordmann showed in his paper "Modal Parameter Identification and Sensitivity analysis in Rotating machinery" that the complex frequency response function also can be written with respect to the eigenvalues \( \lambda_j \) and the corresponding eigenvectors \( \varphi_j, \psi_j \).

\[
H_{kl}(\Omega) = \frac{\tilde{q}_k}{f_l} = \frac{q_k}{f_l} e^{-i\varepsilon_{kl}} = \sum_{j=1}^{2N} \frac{\varphi_{kj} \psi_{lj}}{i\Omega - \lambda_j} \quad (5)
\]

Just a set of frequency response functions allow already to obtain the modal parameters of a rotating structure. When executing the hammer tip testing a broad frequency range and therefore it is a very fast tool. Sine testing for example just excites one frequency at a time and is therefore a slow. To obtain
the column of the FRF Matrix the excitation has to be done at location $l$ and the measurement of displacement takes place at location 2, 4, 5 and 7. When obtaining a row of the FRF Matrix, the excitation takes place at location 2, 4, 5 and 7 and the displacement is measured at location $k$. [6]  

![Figure 26 Excitation and response location](image1)

**Dactron Photon™**  
To compute the time and frequency measurement a dynamic signal analyzer is used. It consists of the Dactron Focus II Real-Time Signal Analyzer and the Dactron Photon™.  

![Figure 27 Dactron Focus II Real-Time Analyzer and Dactron Photon](image2)
The Dactron Focus II Real-time Signal Analyzer computes the frequency domain. Therefore time domain traces are transformed by using the Fast Fourier Transformation (FFT). Before the FFT can be performed on the signal, an analog to digital conversion (ADC) has to be carried out. Therefore the Nyquist sampling theory has to be fulfilled.

\[ S_R > 2f_{max} \]  \hspace{1cm} (24)

\( S_R \) is the sampling rate and \( f_{max} \) is the highest measured frequency. The error that occurs when the sampling rate is too low is called aliasing. Therefore an anti-aliasing filter is used, it prevents an error when sampling with too high frequencies.

The FFT is necessary to properly analyze complex signals. When just the time domain trace is available it is difficult to determine the frequencies of a signal. By transforming this signal the frequency components can be seen simpler.

After the rotor machinery has been setup, one column of \( H(j\omega) \) is obtained by measuring the response at the same place and exciting the rotor on four different spots.

The frequency measurement computed by the Dynamic Signal Analyzer includes the Fast Fourier Transform, Power Spectral Density, Frequency response Functions, Coherences and various others. Signals are computed in the Dactron Phonton with the RT Pro Focus 6.06 Software, where the time data is digitized. The time data is sampled into the DSP block by block, which is also called a time record or time window. [14]
**FFT Windows**

The FFT computation assumes that signals satisfy a periodic requirement, which means that the signal is identical every time. The transient signal also satisfies this requirement. A transient signal starts at zero at the beginning, rinses to a maximum and decays to zero before the end of the time window. When the FFT of a non-periodic signal is computed, leakage might occur. Therefore window functions have to be applied. Windows are shaped that it is zero at the beginning and end.

Windowing functions must be applied to correct measurement errors, which are known as leakage (occurs when FFT is estimated from a non-periodic data block). When windowing is not applied, an error might occur in the FFT amplitude, frequency or overall shape of the spectrum.

**Windows:** Weighting functions are applied to the measured data to minimize leakage. For that reason the distortion effects of leakage are reduced by forcing the data to be more fitting to the periodicity requirements of the Fourier Transform process. Since windows (weighting functions) cause distortion as well so they should be avoided if possible. Usually the following windows are used to minimize the leakage of experimental data:

- Uniform
- Hanning
- Flat Top
- Force/ Exponential

<table>
<thead>
<tr>
<th>Type of Signal</th>
<th>Exponential</th>
<th>Force</th>
<th>Hanning</th>
<th>Flat Top</th>
<th>Uniform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transients whose duration is yes</td>
<td>yes</td>
<td></td>
<td>yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>------------------</td>
<td>------------------</td>
<td>------------------</td>
<td>------------------</td>
<td></td>
</tr>
<tr>
<td><strong>longer than the length of the window</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>General-purpose applications</strong></td>
<td></td>
<td></td>
<td></td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td><strong>Spectral analysis (frequency-response measurements)</strong></td>
<td>Yes (pseudorandom excitation)</td>
<td>Yes (random excitation)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Accurate single-tone amplitude measurements</strong></td>
<td></td>
<td></td>
<td>yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Sine wave or combination of sine waves</strong></td>
<td></td>
<td></td>
<td>yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Sine wave and amplitude accuracy is important</strong></td>
<td></td>
<td></td>
<td>yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Narrowband random signal (vibration data)</strong></td>
<td></td>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Broadband random (white noise)</strong></td>
<td></td>
<td></td>
<td></td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td><strong>Closely spaced sine waves</strong></td>
<td>yes</td>
<td></td>
<td></td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td><strong>Excitation signals (hammer blow)</strong></td>
<td></td>
<td></td>
<td>yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Response signals</strong></td>
<td>yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Unknown content</strong></td>
<td></td>
<td></td>
<td></td>
<td>yes</td>
<td></td>
</tr>
</tbody>
</table>

The force and exponential windows are used when an impact test is performed.

The exponential window is used for transients whose duration is longer than the length of the window. The force window is applied on excitation signals (like the impact hammer).

The Hanning Window forces the sample in the beginning and end of the interval to be zero. This offers advantages when the signal does not fulfill the requirements of the FFT process and is the most commonly used.

The Flat Top window is the most common function used for sinusoidal signals which do not fulfill the periodicity requirement of the FFT process.

Uniform signals are applied when the entire signal is captured in one record or when the data is assured to satisfy the periodicity requirements of the FFT process. For impact testing this window can be used just if the response signals are monitored within one sample of collected data. Sine chirp, digital stepped sine and pseudo-random are all signals that fulfill the periodicity requirements of the FFT process. [14]
Generally all windows will cause degradation of the peak amplitude of the function and therefore the actual measurement will appear to have more damping than what actually exists.

**Window for Impact Measurements**
When using an impact hammer, the exponential windowing is the most suitable. It is specifically developed for modal analysis and has two parts, which are the pre-window at the beginning of the time frame, which removes any noise before the impact (length of this hold-off period is chosen by the user over the pre-trigger time) and the exponential window. The exponential window forces the response data to zero by the end of the frame.

**Obtaining Data**
Data is collected with the same measurement probes that were used in the previous experiment for the balancing of the rotary machine. The output signals of the four probes (for vertical and horizontal testing respectively) of the Rotor Kit Proximitior Assembly were split and lead to the Dactron Focus II Real-Time Analyzer.
To obtain the Data the program RT Pro Focus is used; the setup therefore is described in Appendix D. After the data has been captured it was imported as an *.uff file in MEScope for further analysis and examination. [16]

To execute the hammer test for obtaining a row of the $H(j\omega)$ matrix following procedure has to be done:

1. **Signal Setup > Auto Channel Signals** for Channel 1 (hammer) and 2 (displacement probe) Time Capture, FFT and Power Spectra was chosen.

2. **Signal Setup > Cross Channel Signals** for Channel 2 Power spectra, FRF/ Coh and Excitation 1 was pressed. $H2 = \frac{G_{21}}{G_{11}}$ was chosen, since a row will be captured.

3. To start capturing data **Start** has been pressed and the rotor machine has been excited at the appropriate position; Since probe 2 is on the input Channel 2 $H_{21}$ has been obtained.

4. After the data has been collected, **Stop** was pressed. To measure the next FRF $H_{22}$ **Next Point** is pressed, Figure 29 shows the excitation of
location 2. The procedure is repeated until the whole row has been captured.

Figure 30 Excitation at location 2

5. It is also possible to obtain the whole FRF Matrix by choosing under

**Signal Setup**>**Auto Channel Signals** Channel 2, 3, 4 and 5 and **Signal Setup**>**Cross Channel Signals** for Channel 2, 3, 4 and 5 Power spectra, FRF/ Coh and Excitation 1.

The results are shown in the RT Pro Focus Window and for further examination are imported in MEScope.
Animation with MEScope

MEScope is used to build and animate a simplified model. ME Scope offers three different options for the Modal Analysis. They all build up on the performance of the former option and are Modal Analysis, Multi-Reference Modal Analysis and Operating Modal Analysis. For the scope of this thesis just the Modal Analysis option has been used. The Modal Analysis option offers the possibility to obtain the mode shapes and operation deflection shapes which gives the opportunity to determine if a resonance is excited. The operation deflection shapes demonstrate how the examined structure vibrates and shows for various points and directions where the exaggerated vibration occurs.

The Modal Parameters frequency, damping and residues for each mode are estimated by curve fitting an analytical FRF parametric model to a set of experimental FRF data. The estimated modal parameters are collected into a Shape Table and can be animated on a 3D model.
In the Appendix E the procedure to build and animate the model is given. Furthermore the exact steps to perform the curvefitting in ME Scope are described.

**Results**
Following the results for vertical excitation and vertical measurement are shown and discussed. The reference DOF is the accelerometer point (here the displacement point).

![Figure 32 Simplified Model in Structur Window of MEScope](image)

With the results from the measurement the simplified model can be animated. The modes can be visually seen. To obtain more information, curvefitting has to be done. The modal parameter estimation phase (curvefitting) is used to obtain the modal characteristics from the measured data. Therefore a mathematical algorithm is used. The FRF is broken down into various single DOF systems.
Different techniques to do this are possible, but generally all of them break down measured data into principal components (which are the dynamic characteristics frequency, damping and mode shapes).

Figure 33 Curve Fitting
The result for Mode Shape 1 looks like expected, unfortunately Mode Shape 2 shows a sudden decrease, which can be due to a measurement mistake.

The results of the mode shapes which were obtained by curvefitting the data from the experimental measurements are used for further processing to update the mathematical model developed with a matlab code and an ABAQUS model. The assumption is made that the experimental data is correct and the models are adopted to those.
Chapter 3 – Finite Element Model with Abaqus

 Modeling – Introduction

Often a mathematical representation of a rotor system is used to model how an applied force is transformed into vibration. It is important to simplify the model and decide which assumptions have to be made. Obviously the mathematical representation shows variations to reality. Then it is necessary to evaluate whether the assumptions are reasonable.

In the context of this thesis a finite element model has been modeled with ABAQUS and Matlab. The following is a description of the Finite Element Model in ABAQUS with relevant terms defined. [7]

Structured process to model the physical rotor system

Statement of Assumptions

1. Parts of rotor system: The rotor system includes the attached disks and the bearings that support the shaft. The bearings are represented by attached dampers and springs. Structures that support the bearings, the foundation system, coupled machines and the cabling are neglected.

2. The model has 1-Complex-Degree-of-Freedom (1-CDOF): Since the model has just one moving element, the system is described just with one position measurement variable \( r \) (independent, lateral and complex), no angular deflection and one differential.

3. The model is isentropic; therefore all properties are radial symmetric and a compact mathematical model description is allowed.

4. Neglecting gyroscopic effects
5. **No fluid interaction;** since no parts of the model rotate with a fluid-filled cylinder

6. **Damping** will be due only within the bearings.

7. **Model is linear;** the duplication of the input by a constant factor causes a duplication of the output by the same factor. Real rotor machines behave in a nonlinear manner, but the added complexity is not necessary for small motions. [5]

**Definition of Coordinate System:**

![Figure 35 Definition of Coordinate System](image)

The X-plane goes through the geometry center of the rotor model.

**Acting forces on the system**

Rotor Systems are subjected to static (constant in direction and time) and dynamic forces (change in magnitude or direction through time). Static forces produce a static deflection, whereas dynamic forces produce vibration, which can be torsional, radial and axial. Radial is the most common vibration problem, whereas axial is less frequent. Usually torsional vibration is neglected since it is
difficult to measure. Through cross-coupling mechanisms torsional and axial vibration can produce radial vibration. [7]

**Derivation of equation of motion**

As shown in Chapter 1 – Equation of motion, the equation of motion with no fluid reduces to:

\[ M \ddot{r} + D \dot{r} + Kr = mr_0 \omega^2 e^{j(\omega t + \delta)} \]  \hspace{1cm} (25)

The term on the right-hand side is equal to zero if a free (unformed) behavior of the system is described.

**Solution of equation of motion**

The solution of the equation of motion (shown in Chapter 1 – Equation of motion) with the use of the general expression for \( r \) and various substitutions and eliminations is:

\[ Ae^{j\alpha} = \frac{mr_0 \omega^2 e^{j\delta}}{[K-M\omega^2+jD(\omega-\Delta\Omega)]'} \]  \hspace{1cm} (26)

which describes for the moment that the Keyphasor event occurs the amplitudes and absolute phases.

**Modeling rotary machinery in ABAQUS CAE**

Abaqus/CAE consists of different modules which accomplish different tasks and therefore define an aspect of the modeling process. When modeling, the user moves from module to module. After the model is built, the input file is submitted for the analysis and the results can be visualized. All the required information to perform the analysis is contained in the Abaqus/CAE model container.

These modules include:
• Part (the geometry for the problem is created, for 3-D first the 2-D profile has to be created)

• Property

• Assembly

• Step

• Interaction

• Load

• Mesh

• Job

• Visualization

• Sketch

**Units**

It is very important to decide which system of units will be used, since Abaqus has a no built-in system of units. In this project the Unit system SI(mm) is used.

<table>
<thead>
<tr>
<th>Table 2 System of Units</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Quantity</strong></td>
</tr>
<tr>
<td>Length</td>
</tr>
<tr>
<td>Force</td>
</tr>
<tr>
<td>Mass</td>
</tr>
<tr>
<td>Time</td>
</tr>
<tr>
<td>Stress</td>
</tr>
<tr>
<td>Energy</td>
</tr>
<tr>
<td>Density</td>
</tr>
</tbody>
</table>

**Part Module**

The rotor machinery first was sketched in the Part Module

1. ABAQUS/CAE and then File> New Model Database> With Standard/ Explicit Model was opened.
2. From Module> Part was chosen.

3. Create Part> Type: Deformable> Shape: Solid Shape> Type: Extrusion>
   Approximate size: 560

A deformable body can change its shape (deformation: motion in which a change of shape takes place). The contrast is a rigid body, which can only undergo rigid body motions.

4. With the Edit Feature, the model can be revolve with an 360 degree angle

5. With Part> Create Round or Fillet the edges of the disks are rounded.
6. To define the local coordinate system with Part> Create Datum CSYS: 3

Points> Coordinate System Type: Rectangular> Continue…> Select a Point to be the origin – or enter X, Y, Z: (0.0, 0.0, 0.0)> Press Create

Datum is chosen.

Modeling Springs

To model the bearing following assumptions are made: The bearing on the left will be modeled with springs and dampers in Y- and Z-direction and the coupling from the shaft to the electric motor will be modeled with springs and dampers in X-, Y- and Z-direction.
The springs will be attached in the center of the outer surface of the rotor. Therefore a reference point on each side has to be created.

Creating the reference point to attach the springs and dampers:

1. Part> Create Datum Plane: Offset from principal plane> XY Plane> Offset: 0. The created plane will be used to partition the model.

2. Part> Partition Cell: Define Cutting Plane> Point & Normal, Pick Point and the axis normal to the point. Another way of doing it: Create Partition> Cell> Use datum plane

3. To create a point on the partition: In the dropdown menu: Tools> Reference Point> Select point to act as a reference point – or enter X, Y, Z: First (0.0,0.0,0.0,0.0) for the left surface and (579.0, 0.0, 0.0) for the right surface. Then Create Partition> Edge> Specify Parameter by location.
Click on partition and then the created point. Detail from the rotor with partition edge and cell in red.

![Create Partition dialog box](image)

**Figure 42 Partition Edge and Cell and Create Partition 2 (right figure)**

4. In the model tree> Engineering Features> Springs/Dashpots

<table>
<thead>
<tr>
<th>Degree of Freedom</th>
<th>Orientation</th>
<th>Left Side</th>
<th>Ride Side (Coupling)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Spring Stiffness</td>
<td>Dashpot Coefficient</td>
</tr>
<tr>
<td>1</td>
<td>X</td>
<td>Yes, value: 80 N/mm²</td>
<td>10 N/mm</td>
</tr>
<tr>
<td>2</td>
<td>Y</td>
<td>Yes, value: 80 N/mm²</td>
<td>10 N/mm</td>
</tr>
<tr>
<td>3</td>
<td>Z</td>
<td>Yes, value: 80 N/mm²</td>
<td>10 N/mm</td>
</tr>
<tr>
<td>4</td>
<td>θₓ</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>θᵧ</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>θz</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Property Module**

1. Select Create Material from the Property Toolbox
While building the whole model it is important to maintain one type of unit.

Here the SI (mm) system of unit is used. As material name enter Steel and following values have been typed in:

General> Density from drop-down menu and type in Density 7.5440533E-009
(Calculated over weight and geometry of rotary machinery)

Obtaining density of rotary machinery:

<table>
<thead>
<tr>
<th></th>
<th>Disk</th>
<th>Beam</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>0.79378 kg</td>
<td>0.326019 kg</td>
<td>1.913579 kg</td>
</tr>
<tr>
<td>Volume</td>
<td>106799 mm³</td>
<td>40055.30633 mm³</td>
<td>253653.3063 mm³</td>
</tr>
<tr>
<td>Density</td>
<td></td>
<td>7.5440533 x 10^{-9} t/ mm³</td>
<td></td>
</tr>
</tbody>
</table>

Calculations:

\[ V = \pi \cdot r^2 \cdot h = 2 \cdot r_{disk}^2 \cdot h_{disk} + \pi \cdot r_{beam}^2 \cdot h_{beam} \]
\[ V = 2 \cdot \pi \cdot (37.25mm)^2 \cdot 24.5mm + \pi \cdot (5mm)^2 \cdot 510mm = 253653.958 mm³ \]
\[ \varphi = \frac{m}{V} = \frac{1.913579 \cdot 10^{-3} t}{253653.3063 mm³} = 7.5440533 \cdot 10^{-9} \frac{t}{mm³} \]

a. Youngs modulus 209000 and Poisson’s ratio 0.3 (Mechanical> Elasticity>

Elastic from drop-down menu). Also reference temperature (273.15) and expansion coefficient 13.0*10^-6.

2. Select Create Section from the Property Toolbox. Type in for name RotorSection. The Rotary Machine is of solid and homogeneous type.

Homogeneous means that the property of the part is common throughout.
3. On property toolbox> Assign Section and select the whole part from the viewport. Then select created Section “RotorSection”

**Assembly Module**

Assembly usually means that all created parts are assembled in this module together, but even if just one single part has been created, it has to be included to the assembly.

1. Assembly Toolbox> Instance Part

2. Select the created part. Instance type: Independent.

Instance Part will make a copy of the part. By choosing dependent, all of the mesh information comes of the same part. Independent means that different mesh information comes from different copies of the part.
Step Module

In this module the variables that are included in the output files can be selected. Furthermore loads over a step can be applied.

Creating analytical step:

1. In module tree> Steps> Create Step> name: NaturalFreq. From the list:
   > Linear Perturbation > Frequency> Continue> Lanzos as Eigensolver>
   Number of eigenvalues> Values:10> OK

The initial step is defined, in which the boundary condition which constrains the rotation of both ends is applied. The rotation in $\theta_y$ and $\theta_z$ is fixed.

Applying boundary condition:

2. Model Tree> BCs container> Create Boundary Condition> name: Fixed>
   Step: Initial> Type: Displacement/ Rotation> Chose UR2 and UR3 for $\theta_y$
   and $\theta_z$
Interaction Module

The outer surfaces of the beam are defined as rigid. This means they will maintain the same shape, but they can rotate and translate. No local high stresses and no large local deformations will occur.

1. In the model tree> double click on Constraints> Rigid body> Continue… >Region type: Tie (nodes)
Meshing Module

To mesh the module, more partitions have to be assigned. The meshing of the model cannot be carried out in one step, when the three-dimensional solid element type hexahedral wants to be applied. Therefore more partitions have to be assigned to the part. The partitions have to be executed at the rotor disks and the meshing of the part has therefore to be done separately.

1. Assigning mesh controls, which examines the technique, which Abaqus/CAE is using to mesh the model and the shape of the elements that will be generated. In the main menu bar> Mesh> Controls> acceptHex
2. Assigning the Abaqus element type: Mesh > Element Type > Standard as default Element Library, Linear as Geometric Order, 3D Stress as Family of elements.

3. Creating the mesh

![Regular cube Region modeled with a Single Hexahedron](Image)

The approximate global size of 10 will generate 3087 elements on the part with 4896 nodes. The hexahedron is of the type C3D8R, which means that it is three dimensional, with 8 nodes and with reduced integration. The results are attached for in the Appendix.

Job Module

1. On the Job Container, double click on Job to create a job. Create Job box appears > name: Modes

2. Click Job Manager > Click Submit. After the Job is submitted, the Job’s statues is indicated next to the Job. The status is as following:

   - **Submitted**, which means that the analysis input file is being generated
   - **Running**, which means that Abaqus is analyzing the model
   - **Completed**, which means that the analysis is completed and the output has been written to the output database. Status **aborted** is
written if there is a problem in the Abaqus input file. Additionally the a problem report is displayed.

Results

![Step/Frame Results]

Figure 50 Results Step/Frame
From the Finite-Element Model the natural frequency for the first mode can be found at 2018 rpm and the natural frequency for the second mode is at 4153 rpm. Compared to the experimental obtained data that is for the first mode 90.23% and for the second mode it is 74.40%.
Chapter 4 – Matlab Finite Element Model Creation

A mathematical model of the rotatory machinery is created by using the MATLAB program. MATLAB is a high-performance programming language based environment that integrates computation, visualization, and programming. Problems and solutions can be expressed in common mathematical notation. The described method could as well be used in a FEA code such as ABAQUS. This simplified model illustrates the details on a smaller number of elements.

To obtain the mathematical model, first the matrix for a single beam element has to be assembled. To derive the matrix, the Bernoulli-Euler Theorem is used. The natural frequencies and mode shapes can be determined. The values for the stiffness and damping parameters for the bearings are unknown and for that reason assumptions are used. Therefore, the result is a very simplified model, however, the solutions are likely to be different from those obtained in the experimental measurement. Since the assumption for the damping parameters are made, the results from the experimental measurements are correct, and the mathematical model will be adapted. The obtained global matrices, with their degrees of freedom, have to coincide with the degrees of freedom from the experimental measurements. The Guyan Static Reduction Method is executed. Finally the reduced matrices lead to an error function from which you can obtain the unknown bearing parameters and allow the adaptation of the mathematical model to the experimental model. [1] [18] [21]
**Bernoulli-Euler Beam Theorem**

In this method a simplified uniform element is considered. The beam element has the length $L$, the mass density ($\rho$), the modulus of elasticity $E$, the cross-sectional area ($A$), and the moment of inertia ($I$).

The beam element experiences a transverse motion. The displacement can be simply interpolated over $0 \leq x \leq L$:

$$v(x, t) = \sum_{i=1}^{4} \psi_i(x) v_i(t) \quad (27)$$

The shape functions have to satisfy following boundary conditions:

$$\psi_1(0) = 1, \; \psi_1'(0) = \psi_1(L) = \psi_1'(L) = 0$$

$$\psi_2(0) = 1, \; \psi_2'(0) = \psi_2(L) = \psi_2'(L) = 0$$

$$\psi_3(L) = 1, \; \psi_3'(0) = \psi_3(0) = \psi_3'(L) = 0$$

$$\psi_4(L) = 1, \; \psi_4'(0) = \psi_4(0) = \psi_4'(L) = 0$$

![Figure 53 Uniform element undergoing transverse deflection](image)

The shown beam in Figure 53 shows an element of a regarded beam statically loaded by end shears and bending moments. The result produces numerous deflection shapes. Therefore the equilibrium equation for an uniform end loaded beam is:
\((EIv''')'' = 0\) , the general solution for a uniform beam therefore is

\[v(x) = c_1 + c_2 \frac{x}{L} + c_3 \left( \frac{x}{L} \right)^2 + c_4 \left( \frac{x}{L} \right)^3\]  \hspace{1cm} (28)

By substituting the boundary condition in this cubic polynomial solution of the equilibrium equation, following shape functions are obtained:

\[
\psi_1(x) = 1 - 3 \left( \frac{x}{L} \right)^2 + 2 \left( \frac{x}{L} \right)^3
\]

\[
\psi_2(x) = x - 2L \left( \frac{x}{L} \right)^2 + L \left( \frac{x}{L} \right)^3
\]

\[
\psi_3(x) = 3 \left( \frac{x}{L} \right)^2 - 2 \left( \frac{x}{L} \right)^3
\]

\[
\psi_4(x) = -L \left( \frac{x}{L} \right)^2 + L \left( \frac{x}{L} \right)^3
\]

By inserting the shape functions in the expressions for \(m_{ij}\) and \(k_{ij}\) for Bernoulli-Euler Beams,

\[
k_{ij} = \int_0^L EI \psi_i'' \psi_j'' \, dx \quad \text{(29)}
\]

\[
m_{ij} = \int_0^L \rho A \psi_i \psi_j \, dx \quad \text{(30)}
\]

the following stiffness and mass matrices are obtained:

\[
k = \frac{EI}{L^3} \begin{bmatrix}
12 & 6L & -12 & 6L \\
6L & 4L^2 & -6L & 2L^2 \\
-12 & -6L & 12 & -6L \\
6L & 2L^2 & -6L & 4L^2
\end{bmatrix}
\]

\[
m = \frac{\rho AL}{420} \begin{bmatrix}
156 & 22L & 54 & -13L \\
22L & 4L^2 & 13L & -3L^2 \\
54 & 13L & 156 & -22L \\
-13L & -3L^2 & -22L & 4L^2
\end{bmatrix}
\]

As can been seen, both of the matrices are symmetrical. [8]
Assemblage of Matrices

The assemblage for two beam elements is shown below. This is necessary to obtain the global stiffness and mass matrices.

![Diagram of two beam elements with attached springs](image)

The elements have each two nodes and share one of them with each other.

Since neighboring elements share nodes, the contributions need to be assembled in global matrix.

One node has two degree of freedoms; one translational and the other rotatory.

This means every element has four degrees of freedom and in total the system has six degrees of freedom. To obtain the global matrix, the local matrices have to be assembled. Each element has a local coordinate. In this case the local coordinate axes coincide with the global x and y axes of the overall beam.

The matrices obtain from the Bernoulli-Euler Beam Theorem are used.

\[
K^1 = \frac{EI}{L^3} \begin{bmatrix}
12 + k1 & 6L & -12 & 6L \\
6L & 4L^2 & -6L & 2L^2 \\
-12 & -6L & 12 & -6L \\
6L & 2L^2 & -6L & 4L^2 \\
\end{bmatrix}
\]

\[
K^2 = \frac{EI}{L^3} \begin{bmatrix}
12 & 6L & -12 & 6L \\
6L & 4L^2 & -6L & 2L^2 \\
-12 & -6L & 12 + k2 & -6L \\
6L & 2L^2 & -6L & 4L^2 \\
\end{bmatrix}
\]
The stiffness for the spring $k_1$ and $k_2$ has been added to the stiffness matrix at the appropriate degree of freedom. [9]

The direct stiffness method is used to assemble the stiffness matrix. The element matrices are therefore added to a global matrix in the row and column position determined by the nodes (DOF). The governing equation for the beam is then given by:

$$\begin{bmatrix}
y_1 & \varphi_1 & y_2 & \varphi_2 & y_3 & \varphi_3
\end{bmatrix}
\begin{bmatrix}
12 + k_1 & 6L & -12 & 6L & 0 & 0 \\
6L & 4L^2 & -6L & 2L^2 & 0 & 0 \\
-12 & -6L & 12 + 12 & -6L + 6L & -12 & 6L \\
6L & 2L^2 & -6L + 6L & 4L^2 + 4L^2 & -6L & 2L^2 \\
0 & 0 & -12 & -6L & 12 + k_2 & -6L \\
0 & 0 & 6L & 2L^2 & -6L & 4L^2
\end{bmatrix}$$

**Current Model**

Through the experiments and measurements the natural frequency and node shapes of rotatory machinery are obtained. These values are used to invent a mathematical model. Therefore, the rotatory machine is split in seven elements and eight nodes. Each node has two degrees of freedom. The stiffness matrix for element one, will include the stiffness of the bearing $k_1$, element 7 will include the stiffness of the bearing $k_2$ at the appropriate degree of freedom. The mass matrix for element two, three, five and six will include the lumped disk mass. Also in the figure, are measurement points from the experiment shown; two, four, five and seven. The deflection at point 1 and 8 is not measured but is obtained from a
curve fit of the experimental mode shapes.

The seven (4x4) local stiffness matrices assemble to the global (16x16) stiffness matrix.

The mass matrix is calculated in the same way.
The seven (4x4) local mass matrices assemble to the global (16x16) mass matrix.

**Programming current model**

**Stiffness matrices**

The Bernoulli-Euler Beam Theorem provides the stiffness matrices for the individual elements. These stiffness matrices can be adopted for element two through six. For element one and seven, the stiffness of the bearing has to be added at the appropriate degree of freedom.

Therefore, first the general stiffness matrix has been programmed. For the stiffness matrices for element one and seven the bearing stiffness have to added.

```matlab
syms A %cross section
syms rho % density
syms m % lumped disk mass
syms k1 % stiffness spring 1
syms k2 % stiffness spring 2
syms c1 % damping spring 1
syms c2 % damping spring 2
syms I % moment of inertia
syms Ivar % moment of inertia with rotor element
syms E % modulus of elasticity
syms l % length element
syms d % diameter beam element

l = 0.08 % in m
E = 210*10^9 % steel in N/m^2
I = 4.9087*10^-10 % %pi*d^4/64in m^4, calculated with d=10mm%
k1 = 90*10^6 % N/m
k2 = 90*10^6 % N/m

% stiffness matrix obtained from Bernoulli-Euler Beam Theorem
Kn = [ 12 6*l -12 6*l
       6*l 4*l^2 -6*l 2*l^2
       -12 -6*l 12 -6*l
       6*l 2*l^2 -6*l 4*l^2 ];

a = E*I/l^3;

% stiffness matrices for each beam element of the mathematical model
% k1 and k2 are included at appropriate degree of freedom

K1 = a * (Kn + [ k1 0 0 0
   22 0 0 0
   22 0 0 0
   22 0 0 0 ])

K2 = a * Kn

K3 = a * Kn

K4 = a * Kn

K5 = a * Kn

K6 = a * Kn

K7 = a * (Kn + [ 0 0 0 0
   22 0 0 0
   22 k2 0 0
   22 0 0 0 ])

% mass matrices for each beam element of the mathematical model
% the lumped disk mass m is included at appropriate degree of freedom

Mn = [ 156 22*l 54 -13*l;
   22*l 4*l^2 13*l -3*l^2;
   54 13*l 156 -22*l;
   -13*l -3*l^2 -22*l 4*l^2];

roh= 7850 %kg/ m^3;

d = 0.01% mm;
A=pi*d/4 %mm^2;
m=0.5 % in kg;

b=roh*A*1/420

M1 = b * Mn;
M2 = b * ( Mn + blkdiag(zeros(2),m,zeros(1)));
M3 = b * Mn;
M4 = b * Mn;
M5 = b * ( Mn + blkdiag(zeros(2),m,zeros(1)));
M6 = b * Mn;
M7 = b * Mn;

c1=10;
c2=10;
C = [blkdiag(c1,zeros(5))+blkdiag(zeros(5),c2)];

Assemblage of stiffness and mass matrices
To assemble the stiffness matrices a function is programmed which can be called
out:

K = - 74 -ssembleage( {K1, K2, K3, K4, K5, K6, K7} )

The assemblage-function is built according to:

function [ K ] = - 74 -ssembleage( arrK )
\texttt{shiftSize = 2;} \texttt{\% shifts matrices for 2 columns and 2 rows}

\texttt{numberInputMatrix = length(arrK);} \texttt{\% number of element stiffness matrices}
\texttt{sizeInputMatrix = length(arrK{numberInputMatrix}); \% size of the element stiffness matrices}

\texttt{sizeResultMatrix = shiftSize*(numberInputMatrix-1) + sizeInputMatrix;} \texttt{\% size of global stiffness matrix}

\texttt{K = zeros(sizeResultMatrix, sizeResultMatrix);} \texttt{\% fills the global matrix with zeros}

\texttt{sizeZerosLeft = 0;}
\texttt{sizeZerosRight = shiftSize*(numberInputMatrix-1);}
\texttt{for i=(1:length(arrK)) \% number of element stiffness matrices}
\texttt{K = K + blkdiag( zeros(sizeZerosLeft), arrK{i}, zeros(sizeZerosRight));} \texttt{\% fills the global matrix with element stiffness matrices}
\texttt{sizeZerosLeft = sizeZerosLeft + shiftSize;} \texttt{\% how many zeros are left to the left when filling in every individual el. Stiffness matrix}
\texttt{sizeZerosRight = sizeZerosRight - shiftSize;} \texttt{\% how many zeros are left to the right when filling in every individual el. Stiffness matrix}
\texttt{end}

\texttt{C = assemblage( \{C1, [0], [0], [0], [0], [0], [0], [0], [0], [0], [0], [0], [0], [0], [0], [0], [0], [0], [0], [0], C2\}, 1 )}

The \texttt{Matlab Code} \texttt{[V,D] = eig(K,M)} yields to the natural frequencies and mode shapes.

\texttt{Mode Shapes and Natural Frequencies}

\texttt{[shape,frequency]=eig(K,M) \% frequency are generalized eigenvalues in omega^2}

\texttt{Wn_full=sqrt(frequency) \% rad/s}
\texttt{Vn_full=sqrt(frequency)/(2*pi)*60 \% rpm}

Then various natural frequencies and mode shapes can be compared. This code produces a diagonal matrix \(D\) of generalized eigenvalues and a full matrix \(V\). The columns of the full matrix \(V\) are the corresponding eigenvectors \(K \cdot M = M \cdot V \cdot D\).
The mode shapes:

![Figure 56 Mode Shape 1 for natural frequency 67 rpm](image)

![Figure 57 Mode Shape 2 for natural frequency 560 rpm](image)

**Guyan Reduction Method**

From the mathematical model 16x16 matrices are obtained. Unfortunately this mathematical model is not a sufficient representation for the real rotatory machinery because the stiffness values $k_1$ and $k_2$ and the damping values $c_1$ and $c_2$ are unknown. One method to obtain those and update the mathematical
model is to first match the coordinates of the reference (measured) model and the mathematical model and then use a minimized objective function that measure the distance between the analytical and measured matrices. To realize this, the assumption will be made by using the results of the reference model for the natural frequencies and mode shapes are correct and from there the k1, k2, c1 and c2 values in the stiffness and damping matrices can be evaluated.

Since there is always a mismatch between the coordinates of the finite-element model and those of the measured data, it is an advantage to reduce the systems’ matrices so they meet the measured degrees of freedom. Another possibility is to expand the measured coordinates, so that they correspond to the finite-element model. [3]

In this case the degrees of freedom of the mathematical model will be reduced to meet the degrees of freedom of the reference model. Therefore the **Guyan Static Reduction** (GSR) method is used. It reduces the \([M], [C], [K]\) matrices so that they meet the six Degree of Freedoms of the measurement.

In the Guyan Static Reduction method the state and force vector, \(x\) and \(f\), and the mass and stiffness matrices \((K\) and \(M\)) are split into the measured (master) and unmeasured (slave) subvectors and matrices. The matrices related to the master degrees of freedom are retained and those related to the slave degrees of freedom are eliminated. Since just force is applied to the master degrees, the equation becomes:

\[
\begin{bmatrix}
M_{mm} & M_{ms} \\
M_{sm} & M_{ss}
\end{bmatrix}
\begin{bmatrix}
\ddot{x}_m \\
\ddot{x}_s
\end{bmatrix}
+ \begin{bmatrix}
K_{mm} & K_{ms} \\
K_{sm} & K_{ss}
\end{bmatrix}
\begin{bmatrix}
x_m \\
x_s
\end{bmatrix}
= \begin{bmatrix}
f_m \\
0
\end{bmatrix}
\] (29)

In the following matrix it can be seen, how the matrices are split:
Neglecting inertia terms for the second set of equations leads to:

$$\begin{align*}
K_{sm} \cdot x_m + K_{ss} \cdot x_s &= 0 \\
\end{align*}$$

(30)

This equation is used for the elimination of the slave coordinates and leads to the following equation:

$$\begin{align*}
\begin{bmatrix} x_m \\ x_s \end{bmatrix} = \begin{bmatrix} [I] & [K_{sm}] \\ [-K_{ss}]^{-1} & [K_{sm}] \end{bmatrix} \begin{bmatrix} x_m \\ x_s \end{bmatrix} = [T_s] \begin{bmatrix} x_m \end{bmatrix} \\
\end{align*}$$

(31)

The transformation from the full state vector to the reduced state vector can be obtained from

$$\begin{align*}
\begin{bmatrix} [I] & [K_{sm}] \\ [-K_{ss}]^{-1} & [K_{sm}] \end{bmatrix} = [T_s] \\
\end{align*}$$

(32)

The transformation vector leads then to the reduced mass, stiffness and damping matrices:

$$\begin{align*}
[M_R] &= [T_s]^T [M] [T_s] \\
[C_R] &= [T_s]^T [C] [T_s] \\
[K_R] &= [T_s]^T [K] [T_s] \\
\end{align*}$$
Programming Guyan Reduction Method

For reduced stiffness matrix

Guyan Reduction Method
% to reduce the matrix the transformation matrix has to be found first
% therefore from K Kss (just with the slave rows and columns, here 2 4 5 6
% 8 10 11 12 14 16 has to be build)

\[ K_{ss} = K([2 \ 4 \ 5 \ 6 \ 8 \ 10 \ 11 \ 12 \ 14 \ 16], [2 \ 4 \ 5 \ 6 \ 8 \ 10 \ 11 \ 12 \ 14 \ 16]) \]

% Ksm has to be found where the master row and columns are 1 3 7 9 13 15
\[ K_{sm} = K([2 \ 4 \ 5 \ 6 \ 8 \ 10 \ 11 \ 12 \ 14 \ 16], [1 \ 3 \ 7 \ 9 \ 13 \ 15]) \]
% to obtain T
\[ K_{ssm} = -\text{inv}(K_{ss}) \cdot K_{sm} \] % which is the lower part of the matrix
% and identity matrix (length(Ksssm(1,:)) = columns number)
\[ I_{eye} = \text{eye}(\text{length}(K_{sssm}(1,:))) \]
% this two have to be put together vertically and it is Ts
\[ T_{s} = \text{vertcat}(I_{eye}, K_{sssm}) \]
% then the reduced stiffness matrix can be found out
\[ K_{r} = T_{s}^{\prime} \cdot K \cdot T_{s} \]
% then the reduced mass matrix can be found out
\[ M_{r} = T_{s}^{\prime} \cdot M \cdot T_{s} \]

Leads to following reduced stiffness matrix:

Comparison of the resonant frequency in comparison to the reference (experimental) model:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Reference model in rpm</th>
<th>Mathematical model in rpm</th>
<th>% difference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1800</td>
<td>1115</td>
<td>61.94444</td>
</tr>
<tr>
<td>2</td>
<td>1980</td>
<td>1548</td>
<td>78.18182</td>
</tr>
<tr>
<td>3</td>
<td>5988</td>
<td>3725</td>
<td>62.20775</td>
</tr>
<tr>
<td>4</td>
<td>17280</td>
<td>6532</td>
<td>37.80093</td>
</tr>
<tr>
<td>5</td>
<td>39660</td>
<td>10039</td>
<td>25.31266</td>
</tr>
<tr>
<td>6</td>
<td>43020</td>
<td>19855</td>
<td>46.15295</td>
</tr>
</tbody>
</table>
As can be seen from the correlation between the experimental and computed model data is for the first three modes acceptable, for the fourth, fifth and sixth mode it differ significantly. Therefore a error function was used with the aim to reduce the error in the mathematical model and obtain more compatible results to the reference model. [1]

**Error function**

To modify the structural model matrices, the distances between the mathematical and measured matrices have to be minimized. After Friswell and Mottershead (1995) this is:

\[ [E]_i = (-\omega_i^2[M] + j\omega_i[C] + [K]) \cdot \{\phi\}_i \]  \hspace{1cm} (33)

Where \([M]\) is the mass matrix, \([C]\) the damping matrix, \([K]\) the stiffness matrix, \(\{\phi\}_i\) the \(i\)th mode shape, \(\omega_i\) is the \(i\)th natural frequency, \([E]_i\) the the error vector (residual force) and \(i = \sqrt{-1}\).

In this method the relevant parameters have to change until the error is minimized. [1]

**Structural Dynamics:** The modal properties (the natural frequencies and the mode shapes) which are related to the physical properties of a structure can be described in the matter of their distributed mass, damping and stiffness matrices in the time domain as following:

\[ [M] \cdot \{\ddot{X}\} + [C] \cdot \{\dot{X}\} + [K] \{X\} = \{F\} \]  \hspace{1cm} (34)

Where \(\ddot{X}\) is the acceleration vector, \(\dot{X}\) the velocity vector, \(X\) the displacement vector and \(F\) is the applied force vector.
To form an eigenvalue equation of the $i$th mode, the expression has to be transposed into the modal domain.

$$
(-\bar{\omega}_i^2[M] + j\bar{\omega}_i[C] + [K])\{\phi\}_i = \{0\} \quad (35)
$$

Where $\{0\}$ is the null vector, $\bar{\omega}_i$ is the $i$th complex eigenvalue which correlates to the natural frequency $\omega_i$. $\{\phi\}_i$ correlates to the normalized mode shape $\{\phi\}_i$. It can be seen that the change of the mass and stiffness matrices will change the natural frequencies and mode shapes of the structure.

As a result the detection of the right mass and stiffness matrices leads to the identification of the model properties. As described in the chapter xxx the frequency response function is the ratio of the output response (which can be measured as the displacement, the velocity or the acceleration) as a result of the applied force. The FRF can be expressed over the modal properties by using the modal summation equation.

$$
H_{kl}(\omega) = \sum_{i=1}^{N} \frac{-\omega^2\phi_k^l\phi_i^l}{-\omega^2+2\zeta_i\omega\omega+i\omega_i}\quad (36)
$$

Whereas $k$ is the excitation position and $l$ is the position where the response is measured. $N$ is the number of modes and $\zeta_i$ is the damping ratio. The measured modal properties can be reproduced if the right mass and stiffness matrices are identified. Following the minimized objective function that measures the distance between the analytical and measured matrices is given, with which the parameters $k_1$, $k_2$, $c_1$ and $c_2$ can be upgraded. For $[M]$, $[K]$ and $[C]$ estimated parameters are inserted. $[\Delta C]$ and $[\Delta K]$ contain unknown parameters. To find out the unknown parameters that are contained in $[\Delta C]$ and $[\Delta K]$ the error function is used.
\[ E = \sum_{i=1}^{N} \left( -\omega_i^2 [M] + j \omega_i ([C] + [\Delta C]) + ([K] + [\Delta K]) \right) \cdot \{ \phi \} = 0 \]

Where \( \| \cdot \| \) is the Euclidean form. The mode shapes and natural frequencies are measured. The mass, stiffness and damping matrices are received from the finite element model. If the mode shapes and natural frequencies is expressed over the matrices, then \( E \) is equal to zero.

The minimization of the Error function with respect to \( k_1, k_2, c_1 \) and \( c_2 \) will lead to four linear equations whose solutions gives updated values for the bearing stiffness and damping. [3] [8]

\[
\frac{\partial E^2}{\partial k_1} = 0 \\
\frac{\partial E^2}{\partial k_2} = 0 \\
\frac{\partial E^2}{\partial c_1} = 0 \\
\frac{\partial E^2}{\partial c_2} = 0 
\]

For the \( M, C \) and \( K \) matrices the matrices which were obtain with the Guyan Static Reduction method. For the change of the stiffness and damping values \( [\Delta C] \) and \( [\Delta K] \) following matrices are used:

\[
[\Delta C] = \begin{bmatrix}
\Delta C_1 & 0 & 0 & 0 & 0 & 0 \\
0 & 0 & 0 & 0 & 0 & 0 \\
0 & 0 & 0 & 0 & 0 & 0 \\
0 & 0 & 0 & 0 & 0 & 0 \\
0 & 0 & 0 & 0 & 0 & 0 \\
0 & 0 & 0 & 0 & 0 & \Delta C_2 \\
\end{bmatrix}
\]
Let \((-\omega^2 [M] + ([K] + [\Delta K])) \cdot \{\phi\} = \{\Phi'\}\)

Then

\[
\|(-\omega^2 [M] + ([K] + [\Delta K])) \cdot \{\phi\}\|^2 = \{\Phi'\}^T \{\Phi'\}
\]

\[\frac{\partial E^2}{\partial \Delta k_1} = 0 \text{ yields to } 0\]

\[
= \sum_l \left[(-\omega^2 M_{11} + (K_{11} + \Delta K_1))\phi_1 + (-\omega^2 M_{12} + K_{12})\phi_2 \\
+ (-\omega^2 M_{13} + K_{13})\phi_3 + (-\omega^2 M_{14} + K_{14})\phi_4 + (-\omega^2 M_{15} + K_{15})\phi_5 \\
+ (-\omega^2 M_{16} + K_{16})\phi_6 \right] \phi_1
\]

\[\frac{\partial E^2}{\partial k_2} = 0 \text{ yields to } 0\]

\[
= \sum_l \left[(-\omega^2 M_{61} + K_{61})\phi_1 + (-\omega^2 M_{62} + K_{62})\phi_2 + (-\omega^2 M_{63} + K_{63})\phi_3 \\
+ (-\omega^2 M_{64} + K_{64})\phi_4 + (-\omega^2 M_{65} + K_{65})\phi_5 \\
+ (-\omega^2 M_{66} + (K_{66} + \Delta k_2))\phi_6 \right]
\]

Let \((-\omega^2 [M] + j\omega ([C] + [\Delta C])) \cdot \{\phi\} = \{\Phi'\}\)

Then

\[
\|(-\omega^2 [M] + j\omega ([C] + [\Delta C])) \cdot \{\phi\}\|^2 = \{\Phi'\}^T \{\Phi'\}
\]
\[ \frac{\partial E^2}{\partial c_1} = 0 \text{ yields to } 0 \]

\[ = \sum_l j[-(\Delta C_1 \omega^2 - M_{11} \omega^2) \phi_1 + M_{12} \phi_2 \omega^2 + M_{13} \phi_3 \omega^2 + M_{14} \phi_4 \omega^2 + M_{15} \phi_5 \omega^2 + M_{16} \phi_6 \omega^2] \phi_1 \]

\[ \frac{\partial E^2}{\partial c_2} = 0 \text{ yields to } 0 \]

\[ = \sum_l j[-(\Delta C_2 \omega^2 - M_{61} \omega^2) \phi_1 + M_{62} \phi_2 \omega^2 + M_{63} \phi_3 \omega^2 + M_{64} \phi_4 \omega^2 + M_{65} \phi_5 \omega^2 + M_{66} \phi_6 \omega^2] \phi_1 \]

Before the values of the mode shapes can be inserted in the Error Function, they have to be mass normalized, therefore:

\[
\begin{bmatrix}
0.494 \\
1.91 \\
2.84 \\
2.59 \\
0.808 \\
0.379
\end{bmatrix}
\]

\[
v_1 = \frac{1}{\sqrt{v_1^T \cdot M_R \cdot v_1}}
\]

\[
v_{1\text{normalized}} = \beta \cdot v_1
\]

With \( \beta = \frac{1}{\sqrt{v_1^T \cdot M_R \cdot v_1}} \)

<table>
<thead>
<tr>
<th>shape function 1</th>
<th>shape function 1 normalized</th>
<th>shape function 2</th>
<th>shape function 2 normalized</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.494</td>
<td>0.494</td>
<td>0.172</td>
<td>0.172</td>
</tr>
<tr>
<td>1.19</td>
<td>1.19</td>
<td>0.294</td>
<td>0.294</td>
</tr>
<tr>
<td>2.84</td>
<td>2.84</td>
<td>0.11</td>
<td>0.11</td>
</tr>
<tr>
<td>2.59</td>
<td>2.59</td>
<td>0.136</td>
<td>0.136</td>
</tr>
<tr>
<td>0.808</td>
<td>0.808</td>
<td>0.247</td>
<td>0.247</td>
</tr>
<tr>
<td>0.379</td>
<td>0.379</td>
<td>0.0513</td>
<td>0.0513</td>
</tr>
</tbody>
</table>

Programming normalized shape function in Matlab:

\`
\text{syms } v1 \% \text{ mode shape 1}
\text{v1=[0.172}
\`
\[
\beta = \sqrt{\frac{1}{v_1^\prime \cdot M_r \cdot v_1}}
\]
\[v_{1\text{\_gen}} = \beta \cdot v_1\]

**Programming Error Function**

```
syms deltal1
syms deltal2
deltaK = [blkdiag(deltal1, zeros(5)) + blkdiag(zeros(5), deltal2)]
```

```
syms deltac1
syms deltac2
deltaC = [blkdiag(deltac1, zeros(5)) + blkdiag(zeros(5), deltac2)]
```

```
syms Kr_delta
syms v1
syms v2
syms K_E
syms deltaE
syms diffdeltaE
syms diffdeltaE_deltal1
syms diffdeltaE_deltal2
Kr_delta = Kr + deltaK
```

```matlab
%the modeshape 1 obtained from the experiment
w1 = 29.8*(2*pi)
w2 = 99.6*(2*pi)

phi1 = [0.494
        1.19
        2.84
        2.59
        0.808
        0.379]

phi2 = [0.172
        0.294
        0.11
        0.136
        0.247
        0.0513]

K_E = Kr + deltaK

K_E_K_1 = (-w1^2 * Mr + K_E) * phi1
K_E_K_2 = (-w2^2 * Mr + K_E) * phi2

deltaE_K_1 = K_E_K_1.' * K_E_K_1
```
\[ \Delta \epsilon_{K_2} = \Delta \epsilon_{K_2},'' \cdot K_{E_2} \]

\[ \Delta \epsilon_{K} = \Delta \epsilon_{K_1} + \Delta \epsilon_{K_2} \]

\[ \text{diff} \Delta \epsilon_{\Delta \epsilon_{k1}} = \text{diff} (\Delta \epsilon_{K}, \Delta \epsilon_{k1}) \]

\[ \text{solve} \left( \text{diff} \Delta \epsilon_{\Delta \epsilon_{k1}}, \Delta \epsilon_{k1} \right) \]

\[ \text{diff} \Delta \epsilon_{\Delta \epsilon_{k2}} = \text{diff} (\Delta \epsilon_{K}, \Delta \epsilon_{k2}) \]

\[ \text{solve} \left( \text{diff} \Delta \epsilon_{\Delta \epsilon_{k2}}, \Delta \epsilon_{k2} \right) \]

\text{syms} \Delta \epsilon_{C}

\text{syms} \Delta \epsilon_{c1}

\text{syms} \Delta \epsilon_{c2}

\[ K_{E_1} = (-w_1^2 \cdot Mr + j \cdot w_1 \cdot \Delta \epsilon_1) \cdot \phi_1 \]

\[ K_{E_2} = (-w_2^2 \cdot Mr + j \cdot w_2 \cdot \Delta \epsilon_2) \cdot \phi_2 \]

\[ \Delta \epsilon_{C_1} = K_{E_1} \cdot K_{E_1} \]

\[ \Delta \epsilon_{C_2} = K_{E_2} \cdot K_{E_2} \]

\[ \Delta \epsilon_{C} = \Delta \epsilon_{C_1} + \Delta \epsilon_{C_2} \]

\[ \text{diff} \Delta \epsilon_{\Delta \epsilon_{c1}} = \text{diff} (\Delta \epsilon_{C}, \Delta \epsilon_{c1}) \]

\[ \text{solve} \left( \text{diff} \Delta \epsilon_{\Delta \epsilon_{c1}}, \Delta \epsilon_{c1} \right) \]

\[ \text{diff} \Delta \epsilon_{\Delta \epsilon_{c2}} = \text{diff} (\Delta \epsilon_{C}, \Delta \epsilon_{c2}) \]

\[ \text{solve} \left( \text{diff} \Delta \epsilon_{\Delta \epsilon_{c2}}, \Delta \epsilon_{c2} \right) \]

leads to \( \Delta k_1 = 1.0618 \cdot 10^{13}, \Delta k_2 = 3.0765 \cdot 10^{15}, \Delta \epsilon_1 = 3.2539 \cdot 10^5 \) and \( \Delta \epsilon_2 = 7.5465 \cdot 10^4 \). This was then inserted in the stiffness and damping matrices for a single beam and the matrices were assembled and reduced again. \[1\]

**Verification of Error Function**

On a very simplified Problem the Error Function will be verified.

The following mass and stiffness matrices

\[ M = \begin{bmatrix} 1 & 0 \\ 0 & 1 \end{bmatrix} \]

\[ K = \begin{bmatrix} 4 & 0 \\ 0 & 9 \end{bmatrix} \]

lead to those shapes and eigen frequencies:

\[ \text{shapes} = \begin{bmatrix} 1 \\ 0 \\ 1 \end{bmatrix} \]

\[ \text{frequencies} = \begin{bmatrix} 4 \\ 0 \\ 9 \end{bmatrix} \]
When adding $\Delta K = \begin{bmatrix} \Delta k_1 & 0 \\ 0 & \Delta k_2 \end{bmatrix}$ to the stiffness matrix and applying

$$(-\omega^2[M] + ([K] + [\Delta K])) \cdot \{\phi\} = \{\Phi'\}$$

Following equations are obtained:

$$\begin{bmatrix} -2^3 \cdot \begin{bmatrix} 1 \\ 0 \end{bmatrix} + \begin{bmatrix} 4 + \Delta k_1 \\ 0 \end{bmatrix} & 0 \\ 0 & 9 + \Delta k_2 \end{bmatrix} \cdot \{1\} = \{\Delta k_1 \}$$

With $\|(-\omega^2[M] + ([K] + [\Delta K])) \cdot \{\phi\}\|^2 = \{\Phi'\}^T \{\Phi'\}$ this equations become

$\|\| \cdot \{\Delta k_1 \}^T \cdot \{\Delta k_1 \} = \Delta k_1^2$ for inserting the first mode shape and first natural frequency.

$\|\| \cdot \{\Delta k_2 \}^T \cdot \{\Delta k_2 \} = \Delta k_2^2$ for inserting the second mode shape and second natural frequency.

Considering $\|\sum_{i=1}^N \| = \Delta k_1^2 + \Delta k_2^2$.

$\frac{\partial E^2}{\partial \Delta k_1} = 0$ leads to a $\Delta k_1 = 0$. This proves that the Error Function is equal to zero, when the mode shapes and natural frequency of the system are inserted.

For the further verification

When the mode shapes are changed with just one value, here instead of “0” the value “1” is inserted.

Solves for $\Delta k_2 = -\frac{5}{2}$, when adding $\Delta k_2 = -\frac{5}{2}$ to the original stiffness matrix $K = \begin{bmatrix} 4 & 0 \\ 0 & 9 - \frac{5}{2} \end{bmatrix}$ and applying again the method of the least square with the Error Function it can be proven that now the Error is 0. This proves that this method
uploads the finite-element model in a way that it matches the mode shapes and natural frequencies of experimental obtained data.

**Model Assurance Criterion**

To validate the theoretical model, the computed properties and those detected from the experimental measurement have to be compared. First the predicted/obtained results from the Abaqus finite element model and the Matlab finite element model are compared to the results obtained from the experimental measurement. Then the results from the Matlab finite element are compared to the experimental measurement. This will show the improvement of the Matlab finite element model due to the use of the error function, which allowed to obtain improved values for the stiffness and damping coefficients $k_1$, $k_2$, $c_1$ and $c_2$.

To compare the mode shapes the Model Assurance Criterion (MAC) is used. The MAC method compares the theoretical mode shapes and those obtained from the Abaqus finite element model and the Matlab finite element model. The model assurance criterion is well-known and has been used already by various experts within the last 20 years. After the equation of Allemang and Brown the MAC can be mathematical expressed as:

$$MAC_{cdr} = \frac{\left|\{\phi^{*}_{cr}\}^{T}\{\phi^{*}_{dr}\}\right|^2}{\{\phi^{*}_{cr}\}^{T}\{\phi^{*}_{cr}\}\{\phi^{*}_{dr}\}^{T}\{\phi^{*}_{dr}\}} \quad (37)$$

The indices have following meaning; $c$ is the reference, $d$ is the degrees-of-freedom; $r$ is the mode; $T$ is the transpose; $^*$ is the complex conjugate; and $\{ \}$ is a vector.

The points from the straight-line correlation are used and the least-squares deviation is measured. Therefore a value close to 1 demonstrates that the two
compared mode shapes are well-correlated, whereas a value close to 0 indicates that the mode shapes are less well-correlated. [1]

**Programming MAC in Matlab**

```matlab
syms phi_cr
syms phi_dr
syms MAC

phi_cr=[0.494 %mode shape from experiment
       1.19
       2.84
       2.59
       0.808
       0.379]

phi_dr=[0
       0.1588
       0.9813
       0.8871
       1
       0.9117] %mathematical obtained mode shape

MAC=(phi_cr' * phi_dr')^2/(phi_cr' * phi_cr * phi_dr' * phi_dr)
```

**Results**

Mode Shape 1 and 2 obtained from the mathematical model **before updating** the parameters \( \Delta k_1, \Delta k_2, \Delta c_1 \) and \( \Delta c_2 \):

<table>
<thead>
<tr>
<th>( \Phi_{cr} )</th>
<th>( \Phi_{dr} )</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.494</td>
<td>0.0</td>
</tr>
<tr>
<td>1.19</td>
<td>0.1588</td>
</tr>
<tr>
<td>2.84</td>
<td>0.9813</td>
</tr>
<tr>
<td>2.59</td>
<td>0.8871</td>
</tr>
<tr>
<td>0.808</td>
<td>1.0000</td>
</tr>
<tr>
<td>0.379</td>
<td>0.9117</td>
</tr>
</tbody>
</table>

Leads to an MAC of 0.6647 for the comparison of Mode Shape 1.
Table 7 MAC Mode Shape 2 before Updating

<table>
<thead>
<tr>
<th>$\phi_{cr}$</th>
<th>$\phi_{dr}$</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.494</td>
<td>0.172</td>
</tr>
<tr>
<td>1.19</td>
<td>0.294</td>
</tr>
<tr>
<td>2.84</td>
<td>0.11</td>
</tr>
<tr>
<td>2.59</td>
<td>0.136</td>
</tr>
<tr>
<td>0.808</td>
<td>0.247</td>
</tr>
<tr>
<td>0.379</td>
<td>0.0513</td>
</tr>
</tbody>
</table>

Leads to an MAC of 0.0209 for the comparison of Mode Shape 2.

Mode Shape 1 and 2 obtained from the mathematical model after updating the parameters $\Delta k_1, \Delta k_2, \Delta c_1$ and $\Delta c_2$:

Table 8 MAC Mode Shape 1 after Updating

<table>
<thead>
<tr>
<th>$\phi_{cr}$</th>
<th>$\phi_{dr}$</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.494</td>
<td>0</td>
</tr>
<tr>
<td>1.19</td>
<td>0.1243</td>
</tr>
<tr>
<td>2.84</td>
<td>1</td>
</tr>
<tr>
<td>2.59</td>
<td>0.7927</td>
</tr>
<tr>
<td>0.808</td>
<td>0.5786</td>
</tr>
<tr>
<td>0.379</td>
<td>0.5932</td>
</tr>
</tbody>
</table>

Leads to an MAC of 0.8186 for the comparison of Mode Shape 1.
Table 9 MAC Mode Shape 2 after Updating

<table>
<thead>
<tr>
<th>$\Phi_{cr}$</th>
<th>$\Phi_{dr}$</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.494</td>
<td>1</td>
</tr>
<tr>
<td>1.19</td>
<td>0.8551</td>
</tr>
<tr>
<td>2.84</td>
<td>-0.269</td>
</tr>
<tr>
<td>2.59</td>
<td>0.0376</td>
</tr>
<tr>
<td>0.808</td>
<td>-0.0144</td>
</tr>
<tr>
<td>0.379</td>
<td>0.1097</td>
</tr>
</tbody>
</table>

Leads to an MAC of 0.4208 for the comparison of Mode Shape 2.
Chapter 5 – Conclusions

The main approach of this work to develop and update a finite-element model has been achieved. It has been shown that a very simplified beam model can be used to represent a complex rotary machinery structure. The main reason was to be able to show every step in the overall process of generating and updating a finite-element Model.

Unknown bearing parameters have been added to the global matrices of the mathematical model. Those have been obtained by applying the method of assemblage.

To equate the degree of freedoms of the mathematical model to those obtained from the experimental measurement, the Guyan Reduction Method has been applied.

By applying the method of the least square to the Error Function, which measures the distance of the experimental obtained mode shapes and natural frequencies and the mathematical obtained matrices, the unknown bearing parameters could be obtained and inserted in the originally mathematical matrices.

To validate the theoretical model and those detected from the experimental measurements, they have been compared with the Model Assurance Criterion before and after the updating. For Mode Shape 1 an improvement from 0.6647 to 0.8186 and for Mode Shape 2 from 0.0209 to 0.4208 could have been obtained.

Since the values obtained from the comparison of the updated theoretical model
and the experimental measurements are closer to 1, it has been proven that the mode shapes correlate more than before with each other.

This means that in the scope of this work a specific way of how a finite-element model can be uploaded has been successfully shown. Generally by using the Guyan Static Reduction Method every Finite-Element-Model can be equated to the measurement data. Using the method of the least square with the Error Function is a very reliable iterative method to obtain parameters. Not only the stiffness and damping parameters can be updated, but every parameter that is involved in the system matrices.

For further projects it is very interesting to upload the matrices of the Finite-Element Model obtained from Abaqus. The Abaqus Finite-Element Model consists of many more elements and since the geometry of the whole rotary machinery is considered; it will be a better representation of the actual rotary machinery than a simplified beam model.
### References

<table>
<thead>
<tr>
<th>#</th>
<th>Author(s)</th>
<th>Title</th>
<th>Publisher/Website/Year</th>
</tr>
</thead>
<tbody>
<tr>
<td>[12]</td>
<td>Dan Biddle</td>
<td>Adverse Impact and Test Validation,</td>
<td>Biddle Consulting Group, Inc. 2002</td>
</tr>
<tr>
<td>[15]</td>
<td>Dr. Jim Meagher</td>
<td>Introduction to Spectral Analysis. Lecture Notes for ME 517 provided Fall 2012</td>
<td></td>
</tr>
<tr>
<td>Reference</td>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[19]</td>
<td>A. Jauhola, E. Kinzel, D. Reding, N. Hunter, Modal Parameter for a flat Plate supported by an Oil Film, Department of Mechanical Engineering, 2011</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Appendix A Start and use of ADRE for Windows/ DAIU

1. Click on **File** on the ADRE for Windows main menu> New> No (Continue without saving – in case no important experiments have been done beforehand)

2. File> **Open Database**> to **create a new database** and determine a subdirectory, where everything should be saved. By creating a new database all configuration settings and sample data will be erased. The collection is then carried out by the DAIU (Data Acquisition Interface Unit).

3. **Trigger Event** determines at which event the DAIU begins to collect data. Tab Configure…> Data Acquisition> Trigger Event… >Speed> Press Configure> Keyphasor 1> Insert Over 200 and under 60000 RPM

4. **Sample Mode Configuration** is used to specify which mode to use for the data acquisition and to configure the interval for each mode. It is also possible to use both sampling modes at once. With a trigger event (here...
the speed), the sampling begins and is taken at each interval, which is specified in the dialog box. Sample Mode Configuration> Click on Delta Rpm > Delta Rpm: 25 (Click on increasing and decreasing) >Delta Time: 2 sec. > Select Source: Keyphasor 1

![Sample Mode Configuration](image)

5. The location each channel is identified under **Channel Configuration**. Additionally channel pairs are created that must use the same Keyphasor, since they are required for specific plots (Orbit, Orbit/Timebase).

Transducer configuration identifies the type of transducer used by each channel. Channel Configuration > Active Ch. > Click 1, 2, 3 & 4. Pick BRG 1 Vertical and horizontal with the same Keyphasor 1 and BRG 2 Vertical and Horizontal with the same Keyphasor 1. The Angel for the horizontal Channels must be set to 90R. Tot.> CCW (counter-clockwise).
6. Tab Plots gives the possibility to select the plots that are generated after the data has been collected. Usually Polar, Bode and Real Time are the most important, but it is always also interesting and sometimes necessary (depending what the user is looking at) to generate other plots. Usually all plots are selected.
When clicking configure next to Polar, the window with the **Polar Plot Configuration** is opened. For the polar Plot the following configurations have been chosen:

![Polar Plot Configuration](image)

**Figure 63 Polar Plot Configuration**

When clicking configure next to Bode, the window with the **Bode Plot Configuration** is opened. For the polar Plot the following configurations have been chosen:
When clicking configure next to Real Time, the window with the **Real Time Plot Configuration** is opened. For the polar Plot the following configurations have been chosen.

Tab **Store Enable** is used to start collecting the data in the DAIU. DAIU begins to collect the data at the set trigger event.
Appendix B Balancing of two plane rotary machine

Rotor Kit Rk22
Note for Rotor Kit theta is phase lag measured CW from vertical, Y.

<table>
<thead>
<tr>
<th>Enter Original Vibration Vectors</th>
<th>Mag</th>
<th>Phase (deg)</th>
<th>Shifted phase</th>
<th>file: Balance_2plane.xls saved as Complex nvec</th>
<th>nvec2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Va</td>
<td>2.21</td>
<td>71</td>
<td>19 mls 0</td>
<td>2.08565952507442+0.71955621350316i</td>
<td>nvec</td>
</tr>
<tr>
<td>Vb</td>
<td>3.45</td>
<td>0</td>
<td>90 mls</td>
<td>2.11383104471737E-16+3.45i</td>
<td>nvec3</td>
</tr>
<tr>
<td>Enter Trial Weight Inboard Plane, Plane A</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vna</td>
<td>0.2</td>
<td>135</td>
<td>-45 gm</td>
<td>0.1414235623731-0.1414235623731</td>
<td></td>
</tr>
<tr>
<td>Enter New Vibration Vectors</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Va'</td>
<td>2.24</td>
<td>71</td>
<td>19 mls 0</td>
<td>2.1179616093247+0.729272205984031i</td>
<td>nvec1</td>
</tr>
<tr>
<td>Vb'</td>
<td>3.43</td>
<td>0</td>
<td>90 mls</td>
<td>2.10112960018828E-16+3.43i</td>
<td>nvec4</td>
</tr>
<tr>
<td>Enter Trial Weight Outboard Plane, Plane B</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mba</td>
<td>0.2</td>
<td>157.5</td>
<td>-67.5 gm</td>
<td>0.076535686473018-0.18477590652257i</td>
<td></td>
</tr>
<tr>
<td>Enter New Vibration Vectors</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Va''</td>
<td>2.27</td>
<td>71</td>
<td>19 mls 0</td>
<td>2.14632716661045+0.739039710517746i</td>
<td>nvec2</td>
</tr>
<tr>
<td>Vb''</td>
<td>3.43</td>
<td>0</td>
<td>90 mls</td>
<td>2.10112960018828E-16+3.43i</td>
<td></td>
</tr>
<tr>
<td>The Influence Coefficients</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ha A</td>
<td>0.15</td>
<td>-64.00</td>
<td>154.00 mls/gm</td>
<td>0.065755672019331-0.134819106944878i</td>
<td></td>
</tr>
<tr>
<td>Hba</td>
<td>0.1</td>
<td>45.00</td>
<td>45.00 mls/gm</td>
<td>0.0707106781186545+0.0707106781186545i</td>
<td></td>
</tr>
<tr>
<td>Hab</td>
<td>0.3</td>
<td>-86.60</td>
<td>176.50 mls/gm</td>
<td>0.0183416518804677-0.20544039525668i</td>
<td></td>
</tr>
<tr>
<td>Hbb</td>
<td>0.10</td>
<td>22.50</td>
<td>67.50 mls/gm</td>
<td>0.09238795325111288+0.0362038332365091i</td>
<td></td>
</tr>
<tr>
<td>The Balance masses</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ma</td>
<td>58.10</td>
<td>-143.08</td>
<td>233.08 gm</td>
<td>-46.0948262432694-34.1665460102351</td>
<td></td>
</tr>
<tr>
<td>Mb</td>
<td>24.62</td>
<td>45.88</td>
<td>44.12 gm</td>
<td>17.139800400815+17.676355104366i</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Weightsplitting</th>
<th>( a_1 )</th>
<th>( a_2 )</th>
<th>( m_1 )</th>
<th>( m_2 )</th>
<th>Used 0.4g in 202.5</th>
<th>Used 0.2g in 0</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>202.5</td>
<td>247.5</td>
<td>55.6248801</td>
<td>4.478402369</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>90</td>
<td>0</td>
<td>26.0561241</td>
<td>3.70464854</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

I did use 2g instead
Appendix C Orbit Plots obtained with ADRE

Figure 66 Orbit Plot First Mode Shape, Probe 7
Detailed Orbit Plot for Mode Shape 2, probe 7
Figure 67 Orbit Plot Second Mode Shape, Probe 7
Appendix D RT Pro Focus 6.21

1. After the hardware for the experiment is set up, turn on the DACTRON and the computer and open RT-Pro Focus 6.21.

2. Than the impact hammer output has been connected to one of the input channels and the probes for the X-Y relative displacement measurements have been connected to four different channels.

3. From the RT-Pro Focus 6.21 menu a new project has been started and Modal Data Acquisition has been selected.

4. Than the Signals icon has been selected. In Auto Channel Signals for the five used channels time capture, FFT and power spectra has to be checked. In Cross Channel Signals FRF/Coh has been selected for the input channel for the input channels. The excitation channel default is the channel of the hammer. Click \( H2 = \frac{g_{ii}}{g_{ij}} \) to determine that a row

5. Channel icon has been selected to set acquisition parameters for each channel. All sensors for all tests are described here. For Max Volts the highest to expect voltage amplitude has been selected. For this experiment 10 Volts were chosen. Quantity specifies the type of input signal; therefore displacement has been selected for the probes and acceleration for the impact hammer. In mv/EU the sensitivity level has been selected. The impact hammer has a toggle which allows choosing between 1, 10 and 100. For this experiment it has been set to 100 mv/EU. The exact values can be seen from the manufacturer’s calibration specifications. The probes have a calibration specification of 100 mv/EU.
For the **Coupling** AC, DC or ICP can be set. The coupling ICP stands for integrated circuit piezoelectric sensor. It enables the AC coupling and applies power to the ICP type sensors. ICP AC 0.7 Hz has been chosen for this experiment. For the **Axis** the Z+ has been selected. **I.D.** permits to name the single channels.

6. From the main menu **Setup > Preferences > Miscellaneous** has been selected. There “use channel ID label for signal name” has been enabled. Thus the names selected in the channel settings are used for all signal names. They will appear in all legends for all different windows.

7. Than from the main menu **Setup > Measurement Parameters > Sampling** has been selected. For the frequency span **12800 Hz** has been evaluated. The frequency span defines the upper frequency range for the measurement. The windowing type selects the spectral window which is applied to each frame of the data. Here **Forced/Exponential** has been selected which is the most suitable window for modal data acquisition with an impact hammer. The forced/exponential window applies damping to the time history which guarantees that the response signals completely decay within the data frame period.
8. From Setup > Measurement Parameters > Averaging as the averaging type Linear has been selected. As the average frame number 5 has been determined. The reason for averaging is to increase the statistical accuracy or restrain external noise. When selecting linear averaging each set of data elements (data frames) contributes evenly to the average.

9. In the frequency range dropdown menu 12600 Hz has been selected and 1024 points.

10. From Setup > Measurement Parameters > Triggering the following settings have been selected; Analog Input which guarantees the use of a signal from any enabled input channel. The pre/post trigger has been set to -33. This defines the pre- or the post-trigger time in terms of the number of points. This is very important especially for impact analysis since it assures that also the beginning of an impact impulse is captured. Level defines the trigger event. The value is a percentage of the full EU range. 1% has been selected here. For Run Mode Auto Arm every frame has been evaluated as suitable since this run mode waits for a trigger event.
after a start command, obtains a data frame and then pauses until the next frame command is to re-arm the trigger to collect another data frame.

11. The project has been saved than under Project > Save As… and a suitable file name has been evaluated.

12. From Window > 2D Displays > Two-Pane Horizontal which creates a customized two-pane window and contains two separate and independent user-defined plots. The upper window was used to display the hammer (t) for the impact time trace. Therefore right click and contents has been selected. The same procedure in the lower window with the difference that one of the input signals has been selected.

13. From Window > 2D Displays > FRF Bode Window. The top pane defines the phase in degrees and the bottom pane the magnitude in decibel. With the right click contents have been selected and the FRF signal H1_2,1(f) chosen.

14. From Window > New Window an additional single window has been created. From right click > contents the coherence between the impact hammer and one of the probes, Coh2,1(f). Than Window > Tile has been selected. The coherence gives the possibility to observe the accuracy after every test. A value closer to one means an accurate FRF at that frequency. [15]
Appendix E ME Scope

Following the procedure to building and animate a simplified model of the rotor machinery in ME Scope is described.

Therefore first the model including all its testing points is build. Through the Modal Data Acquisition with DACTRON four testing points have been recorded. The determined FRF measurements are than imported into a Data Block file. Than the FRF measurements have been assigned to the DOFs (Points and Directions) on the model where the measurements were made. Afterwards the model was animated and the approximate mode shapes for each resonance can be displayed.

Figure 69 Main Layout of ME Scope

1. File > Project > New
2. File > New > Structure

3. In Structure Window: File > Options… > Units and chose the suitable units, in this project the metric system is used.

![Structure Units](image)

Figure 70 Units

4. Draw > Drawing Assistant and chose the icon line in the substructure. In the tab Dimensions the length of the line (560 mm) and the number of points (six) can be entered. Under Position global has been chosen.

5. File > Import > Data Block…, which is a *.uff file. This action imports the FRF measurements (which are calculated from the data taken during the roving impact test), from the Modal Data Acquisition and makes it able to display the Operation deflection shapes (ODS).

6. A window with the translate files is opened. Manually the DOFs have to be changed. The Trace DOF is equal to the Roving DOF divided through the Reference DOF; the impact points (where the structure has been excited) are the roving DOFs. The reference DOF is the accelerometer point (here the displacement point). Since there is just one reference DOF this is
called a Single Reference Test. For more accurate results several rows have been recorded.

7. To animate the measured DOFs the **measured animation equations** are created. Therefore the measurement numbers and measurement directions have to be matched. The measurement axes have to be oriented in the direction of the measurement.

8. In the **structure window**: Draw > **Number Points** and then on each point of the model has to be clicked. Click **close** when finished.

9. **Edit** > **Objects** > **Points**
10. **Display > Point labels.** As can be seen each point on the line has its own local measurement axes.

11. **Draw > Animation equations > equation editor**

12. **Edit > select object > select all**

13. **Draw > assin measurement numbers > select match structure and source DOFs**

14. **Window > Arrange > for animation**

15. **Click on animation of structure**

**Procedure for Curve Fitting**

In a frequency band of measurements the numbers of modes have to be determined. Within this frequency band the modal frequency and damping has to be estimated. With these estimates the modal residues can be determined. All modal parameters have to be saved then in a Shape Table file.

1. **Format > Overlay** the FRFs can be overlaid and the resonance peaks at the similar frequency in all FRFs can be determined.

2. By using the **band cursor** only data within the cursor band is curve fitted. This is of advantage because just the valid resonance peaks should be curve fitted and not the entire data of each trace.

3. With the **mode indicator** the number of modes in a cursor band can be approved. **Method>Modal Peaks Function** and then **Count Peaks**.
1. Frequency & Damping > Method: Orthogonal Polynomial > Global > Press Freq. & Damp

2. Residues & Save Shapes > Method: Orthogonal Polynomial > Single Reference > Residues

3. With Save Shapes the values of the Mode Shapes are obtained
Appendix E Remaining MATLAB code

Programming and assemblage of mass matrices
Mn = [156 22*l 54 -13*l; 22*l 4*l^2 13*l -3*l^2; 54 13*l 156 -22*l; -13*l -3*l^2 22*l 4*l^2]

b=roh*A*l/420;

M1= b* Mn
M2 = b * ( Mn + blkdiag(zeros(2),m,zeros(1)))
M3 = b * ( Mn + blkdiag(m,zeros(3)))
M4= b* Mn
M5 = b * ( Mn + blkdiag(zeros(2),m,zeros(1)))
M6 = b * ( Mn + blkdiag(m,zeros(3)))
M7= b* Mn

M = assemblageK( {M1, M2, M3, M4, M5, M6, M7} )

function  [ M ] = assemblageM( arrM )

shiftSize = 2; %shifts matrices for 2 columns and 2 rows

numberInputMatrix = length(arrM); %number of element mass matrices
sizeInputMatrix = length(arrM{numberInputMatrix}); %size of the element mass matrices

sizeResultMatrix = shiftSize*(numberInputMatrix-1) + sizeInputMatrix; %size of global mass matrix

M = zeros(sizeResultMatrix, sizeResultMatrix); %fills the mass matrix

sizeZerosLeft = 0;
sizeZerosRight = shiftSize*(numberInputMatrix-1);
for i=(1:length(arrM)) %number of element mass matrices
  M = M + blkdiag( zeros(sizeZerosLeft), arrK{i}, zeros(sizeZerosRight) ); %fills the global matrix with element mass matrices values
  sizeZerosLeft = sizeZerosLeft + shiftSize; %how many zeros are %left to the left when filling in every individual el. mass matrix
  sizeZerosRight = sizeZerosRight - shiftSize; %how many zeros are %left to the right when filling in every individual el. mass matrix
end
end